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法律资讯 
警告提示系统 

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅

与财产损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。 

 危险 

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。 
 

 警告 

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。 
 

 小心 

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。 
 

 注意 

表示如果不采取相应的小心措施，可能导致财产损失。 

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导

致人身伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。 

合格的专业人员 
本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说

明，特别是其中的安全及警告提示。 
由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危险。 

按规定使用Siemens 产品 
请注意下列说明： 

 警告 

Siemens 
产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 
推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。必

须保证允许的环境条件。必须注意相关文件中的提示。 

商标 
所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。

若第三方出于自身目的使用这些商标，将侵害其所有者的权利。 

责任免除 
我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保

证印刷品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一

版本中。 
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安全信息 1
Siemens 
为其产品及解决方案提供了工业安全功能，以支持工厂、系统、机器和网络的安全运行。

为了防止工厂、系统、机器和网络受到网络攻击，需要实施并持续维护先进且全面的工业

安全保护机制。Siemens 的产品和解决方案仅构成此类概念的其中一个要素。 

客户负责防止其工厂、系统、机器和网络受到未经授权的访问。只有在必要时并采取适当

安全措施（例如，使用防火墙和网络分段）的情况下，才能将系统、机器和组件连接到企

业网络或 Internet。 

此外，应考虑遵循 Siemens 
有关相应安全措施的指南。更多有关工业安全的信息，请访问

(http://www.industry.siemens.com/topics/global/en/industrial-
security/Pages/default.aspx)。 

Siemens 不断对产品和解决方案进行开发和完善以提高安全性。Siemens 
强烈建议您及时更新产品并始终使用最新产品版本。如果使用的产品版本不再受支持，或

者未能应用最新的更新程序，客户遭受网络攻击的风险会增加。

要及时了解有关产品更新的信息，请订阅 Siemens 工业安全 RSS 源，网址为 
(https://support.industry.siemens.com/cs/cn/zh/)。 

http://www.industry.siemens.com/topics/global/en/industrial-security/Pages/default.aspx
http://www.industry.siemens.com/topics/global/en/industrial-security/Pages/default.aspx
https://support.industry.siemens.com/cs/cn/zh/
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S7-PLCSIM 概述 2
2.1 S7-PLCSIM 简介 

S7-PLCSIM 主要用于在不使用实际硬件的情况下调试和验证单个 PLC 
程序。S7-PLCSIM 允许用户使用所有 STEP 7 
调试工具，其中包括监视表、程序状态以及在线与诊断功能等。S7-PLCSIM 还提供了 
S7-PLCSIM 所特有的工具，包括 SIM 表和序列编辑器。  

S7-PLCSIM 与 TIA Portal 中的 STEP 7 结合使用。用户可以在 STEP 7 中组态 PLC 
和任何相关模块，编写应用程序逻辑，然后将硬件组态和程序下载到 S7-PLCSIM 
的精简视图或项目视图中。

参见

Siemens 工业在线支持 (https://support.industry.siemens.com/cs/?lc=zh-CN) 

https://support.industry.siemens.com/cs/?lc=zh-CN
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2.2 S7-PLCSIM V14 有哪些新增内容？ 

S7-PLCSIM V14 的新特性 

S7-PLCSIM V14 包含许多有用的新特性和功能，具体如下：  

 
 

特性 主题 

分离项目和仿真： 项目和仿真状态的概述 (页 89) 

仿真状态：无、未组态、已组态 仿真状态 (页 23) 

使用新的电源按钮启动和停止仿真 仿真循环上电 (页 46) 

精简视图：用户界面和功能的更改 在精简视图中工作的概述 (页 51) 

支持其它硬件： 

S7-1200 Fail-safe 设备 

S7-1500T 

基于 STEP 7 许可证的硬件支持 (页 15) 

 

 

支持 S7-1200 仿真中的通信 仿真通信概述 (页 151) 

支持 S7-1500、S7-1200、S7-300 和 S7-400 
CPU 之间的通信 

仿真通信概述 (页 151) 

撤消和恢复工具栏按钮 撤消和恢复的概述 (页 81) 

设备组态视图：显示分布式 I/O 设备 已下载的中央和分散硬件显示 (页 99) 

拖放模块以创建 SIM 表 拖放设备组态视图中的模块以创建 SIM 表 (页 115) 

序列编辑器：编辑执行时间  编辑执行时间 (页 144) 

序列编辑器：启用和禁用序列步 启用和禁用序列步 (页 148) 

序列编辑器：通过新的工具栏按钮重复序列 通过工具栏按钮重复序列 (页 135) 

序列编辑器：延迟一个操作中的多个步 步时间调整 (页 149) 

序列编辑器：通过导入的 STEP 7 
跟踪测量创建序列 

导入 STEP 7 跟踪以创建序列 (页 129) 

序列编辑器：通过触发条件启动序列 通过触发条件启动序列 (页 136) 

2.3 输入值 
S7-PLCSIM 项目视图 SIM 表编辑器和序列编辑器中的输入区域值相当于“真实”CPU 
上的物理输入。每次扫描周期开始时，都会将这些值复制到过程映像。 
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2.4 安装设置、要求、修复和卸载 

2.4.1 关于仿真 S7-300 和 S7-400 PLC 的重要注意事项 

在先前版本中，安装 TIA Portal 时会自动安装 S7-PLCSIM V5.4.x。但现在则不然。 

如果要使用 TIA Portal V14 仿真 S7-300 和 S7-400 PLC，必须先安装 
S7-PLCSIM V14。安装 S7-PLCSIM V14 时会自动将现有 S7-PLCSIM V14 V5.4.6 
或较低版本升级到 S7-PLCSIM V5.4.7。 

2.4.2 S7-PLCSIM 安装要求 

安装 S7-PLCSIM V14 之前，必须满足以下要求。 

使用支持的操作系统 

S7-PLCSIM V14 支持的操作系统与 TIA Portal V14 
相同。有关支持的操作系统的详细列表，请参见 TIA Portal 在线帮助的“自述文件”部分。 

如果已经成功安装 TIA Portal V14，S7-PLCSIM V14 也应正确安装。 

2.4.3 S7-PLCSIM 安装设置 

S7-PLCSIM 的设置独立于 TIA Portal。  

S7-PLCSIM 必须手动安装。因为其不会作为 TIA Portal 安装过程的一部分自动安装。 

可以在同一个 PG/PC 上安装多个版本的 
S7-PLCSIM，各版本彼此之间互不影响。这一点与 TIA Portal 相同，即，可以在同一个 
PG/PC 上安装多个版本的 TIA Portal 软件（例如，V13 和 V14）。 

与 TIA Portal 交互 

安装期间，安装过程会通过 TIA Portal 注册 S7-PLCSIM，以支持特定 PLC 
系列的仿真。用户无需进行任何操作即可实现注册。 

安装完 S7-PLCSIM 
后，如果支持的设备具有应用程序焦点，则主菜单命令和工具栏按钮会变为启用状态。  
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2.4.4 修复和卸载 S7-PLCSIM 

由于已安装 S7-PLCSIM 软件，因此会在 Microsoft Windows 
控制面板的已安装程序区域进行显示。单击“S7-PLCSIM V14”条目，然后选择卸载或修改

（修复）。 

可以在不影响已安装的其它版本 S7-PLCSIM 或任何其它 SIMATIC 
软件的情况下，修复或卸载 S7-PLCSIM V14。 

2.5 S7-PLCSIM 产品间的差别 
名称中含有“S7-PLCSIM”的产品有许多款。 

S7-PLCSIM⍛ V14（本产品） 

该版本的 S7-PLCSIM 支持以下 SIMATIC CPU 系列： 

● 使用 STEP 7 Basic 许可证时，支持 S7-1200 和 S7-1200F CPUs 

● 使用 STEP 7 Professional 许可证时，支持 
S7-1200、S7-1200F、S7-1500、S7-1500C、S7-1500T、S7-1500F、ET 200SP 和 
ET 200SPF CPUs 

S7-PLCSIM V5.x 

S7-PLCSIM V5.x 可仿真以下 SIMATIC CPU 系列：  

● S7-300 和 S7-300F 

● S7-400 和 S7-400F 

S7-PLCSIM 和 S7-PLCSIM V5.x 
是两款独立的软件应用程序。可以在同一台机器上同时安装并运行这两款应用程序。另外

，还可以组合使用这两款应用程序来仿真通信。 

S7-PLCSIM V14 Advanced 

S7-PLCSIM V14 Advanced 和 S7-PLCSIM V14 
不能安装在同一台机器上。因此，不能组合使用这两款应用程序来仿真通信。  
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2.6 支持的硬件 

2.6.1 基于 STEP 7 许可证的硬件支持 

可使用 S7-PLCSIM 仿真哪些 PLC 取决于 TIA Portal 许可证。 

 TIA Portal Basic 和 S7-PLCSIM 

使用 TIA Portal Basic 许可证时，可在 S7-PLCSIM 中仿真如下 CPU 系列：  

● 固件版本为 4.0 或更高版本的 S7-1200 

● 固件版本为 4.1 或更高版本的 S7-1200F 

如果项目中包含固件版本较低的 PLC，则 TIA Portal 中的“启动仿真”(Start simulation) 
按钮不可选择，因此无法启动仿真。  

可以同时启动和运行 S7-1200 和 S7-1200F（或这两个 CPU 
系列的任意组合）两个仿真。  

TIA Portal Basic 不支持以下 CPU 系列： 

● S7-1500、S7-1500C、S7-1500T 和 S7-1500F 

● ET 200SP 和 ET 200SPF 
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TIA Portal Professional 和 S7-PLCSIM 

使用 TIA Portal Professional 许可证时，用户可以仿真以下 CPU 系列：  

● 固件版本为 4.0 或更高版本的 S7-1200 

● 固件版本为 4.1 和更高版本的 S7-1200F 

● 任意固件版本的 S7-1500、S7-1500C、S7-1500T 和 S7-1500F 

● 任意固件版本的 ET 200SP 和 ET 200SPF 

可以同时启动和运行这些 PLC 任意组合的两个仿真。  

 
 

 
说明 

• S7-1500C 为 S7-1500 系列的精简版本。 

• S7-1500T 为 S7-1500 系列的工艺版本。 

• CPU 系列末尾的 "F" 用于指定该系列属于故障安全版本。 
 

2.6.2 用于识别已升级固件的硬件的步骤 

如果已使用硬件支持包 (HSP) 在 TIA Portal 
中安装或更新了设备的固件，则这些设备可能不会显示在设备组态中。 

如果用户更改硬件的固件版本并尝试使用现有 S7-PLCSIM 
项目，则将收到如下错误：无法加载到目标系统。  

例如，如果用户已将 S7-1500 CPU 从固件版本 1.8 升级至固件版本 2.0，并尝试使用为 
S7-1500（版本 1.8）创建的项目，则会收到上述错误。  
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2.7 S7-PLCSIM 概念 

2.7.1 开始使用 S7-PLCSIM 

S7-PLCSIM 的用户界面包含两个主视图：精简视图和项目视图。  

用户应根据使用 S7-PLCSIM 的意图选择以精简视图还是项目视图启动。 

2.7.2 精简视图和项目视图 

2.7.2.1 以项目视图或精简视图启动 

精简视图 

精简视图包含一个小型主窗口，其中包括有限的控件和功能。以精简视图启动 
S7-PLCSIM 时速度非常快。 

如果要在 STEP 7（而非 
S7-PLCSIM）中调试程序，则该视图将十分有用。精简视图只会占用 PC 
桌面的一小部分，因此在 STEP 7 中调试程序的同时还可以打开 S7-PLCSIM。 

默认情况下，S7-PLCSIM 
以精简视图启动。如果要将项目视图设为默认视图，则可以在项目视图主菜单的“选项 > 
设置”(Options > Settings) 下进行此更改。 

项目视图 

项目视图包含 S7-PLCSIM 的全部功能。项目视图的外观与 TIA Portal 
的用户界面非常类似。 

以项目视图启动 S7-PLCSIM 
或切换至项目视图时，速度要慢于以精简视图启动。这是因为 S7-PLCSIM 
在以项目视图启动的过程中需要整合项目视图的额外功能。 
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项目视图包含多个组件： 

● 主菜单和主工具栏 

● 选项和设置（通过主菜单进行访问） 

● 项目树 

● 设备组态视图 

● SIM 表编辑器 

● 序列编辑器 

如果要使用 S7-PLCSIM 的全部功能（而非在 STEP 7 
中执行调试任务）调试程序，则项目视图将十分有用。 

2.7.2.2 在精简视图和项目视图之间进行切换 

无论您将哪种视图选作默认视图，都可以使用“切换视图”(switch views)  
按钮，轻松在精简视图和项目视图之间进行切换。  

切换视图时所显示的内容取决于切换时的应用程序状态；例如，仿真是否已组态、仿真是

否处于运行状态以及用户使用的项目是否已打开等等。 

例如，当您正在使用精简视图，无法直接创建、保存或使用项目。因此，需要切换至项目

视图来执行上述操作。  

当您正在使用项目视图时，也可能想要切换到精简视图，因为这样 S7-PLCSIM 
便不会占用计算机屏幕过多的空间，从而能够更加高效地在 TIA Portal 中进行工作。  

2.7.3 分离仿真和项目 

对于 S7-PLCSIM V14 之前的版本，项目和运行的仿真是不可分离的。 

对于 
S7-PLCSIM V14，项目和仿真是分离的。不启动仿真即可创建项目，未创建或打开项目

也可以运行仿真。 

2.7.4 启动和停止仿真 

2.7.4.1 启动和停止仿真 

S7-PLCSIM V14 配有一个电源按钮 ，用于启动和停止仿真。  



 S7-PLCSIM 概述 
 2.7 S7-PLCSIM 概念 

S7-PLCSIM V14 在线帮助 
编程和操作手册, V14, 09/2016, A5E38930223-AA 19 

请记住，自 S7-PLCSIM V14 起，启动和停止仿真与创建或打开 S7-PLCSIM V14 
项目相互独立。  

精简视图和项目视图均支持电源按钮，如下方截屏中所示： 
 

精简视图中的电源按钮和 CPU 系列选择器 项目视图中的电源按钮和 CPU 系列选择器 

 

 

 

要启动新仿真，请从下拉列表中选择合适的 CPU 系列，然后单击电源按钮以启动仿真。 

在仿真处于运行状态时，电源按钮呈绿色，CPU 系列选择器处于禁用状态。  

可以通过再次单击电源按钮来停止正在运行的仿真。 

单击电源按钮将结束当前的仿真。这与将仿真设为“STOP”模式不同。对于“真实”PLC而言

，单击电源按钮相当于切断电源。 

无论是否已打开一个 S7-PLCSIM 
项目，都可以停止仿真。如果已打开一个项目，并且当前正处于项目视图中，则会更新项

目树以显示该状态。停止仿真还会导致项目视图转到“离线”状态。用户将无法再运行 SIM 
表或序列。 

在精简视图中，显示内容的变化微乎其微。电源按钮将呈灰色，CPU 
系列选择器将变为可见状态。 
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下列两种用例会需要停止仿真： 

● 要仿真循环上电操作 

● 要更改正在仿真的 CPU 系列 

2.7.4.2 仿真和电源按钮 

精简视图和项目视图均支持电源按钮。可以使用电源按钮开启或关闭仿真。  

当仿真处于运行状态时，无论是否已组态，电源按钮都将呈绿色 。 

当仿真停止运行时，电源按钮将呈灰色 。 

电源按钮使用示例 

下方截屏显示了正在运行已组态的 S7-1500 仿真的精简视图。 

 

● 电源按钮呈绿色 

● 显示了已组态的 CPU 的名称 

● 显示了通信地址 

● LEDs 处于激活状态 

● Run/Stop/MRES 按钮为启用状态 
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单击电源按钮（以关闭仿真）后的结果如下所示。 

 

请注意用户界面中哪些内容发生了变化（未发生变化）： 

● 电源按钮呈灰色 

● 仍显示已组态的 CPU 的名称 

● 通信地址已移除 

● LEDs 为禁用状态 

● RUN/STOP/MRES 按钮为禁用状态 

● 显示了 CPU 系列选项 

停止仿真时会保存该仿真。如果再次单击电源按钮，则会使用仿真停止时的组态启动新仿

真。 

其作用相当于对先前的仿真“循环上电”。 

2.7.4.3 更改正在仿真的 CPU 系列 

更改正在仿真的 CPU 系列是停止仿真的一个原因。 
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更改 CPU 系列的步骤 

返回到上一部分中显示的已停止的仿真： 

 

此时将显示 CPU 系列的下拉列表。单击下箭头将显示所支持的 CPU 系列的列表： 
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如果更改 CPU 
系列后单击电源按钮，则会重新启动一个所选类型的未组态仿真。之前保存的仿真将被丢

弃。随后将显示如下精简视图： 

 

● 显示了“未组态的”CPU 的名称 

● 未显示任何通信地址 

● LEDs 和 Run/Stop/MRES 按钮为禁用状态 

在项目视图中，如果存在已打开的 S7-PLCSIM 
项目，则更改仿真系列并启动新仿真时，项目树将更新以显示新的未组态仿真。 

2.7.5 仿真状态 

有三种可能的仿真状态： 

● 未组态的仿真 

● 已组态的仿真 

● 无仿真 
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未组态的仿真 

如果已选择 PLC 系列，并单击电源按钮使其切换到“接通”状态，但尚未从 STEP 7 
下载特定的 PLC，此时的仿真属于未组态的仿真。  

在该状态下，S7-PLCSIM 将按照下列示例的形式显示 PLC 的名称： 

PLC_1 [SIM-1200] 

PLC_1 [SIM-1500] 

PLC_1 [SIM-ET200SP] 

当您想要在特定 PLC 系列环境下工作但尚未准备好使用特定的 PLC 
时，可以使用未组态的仿真。 

已组态的仿真 

如果已从 STEP 7 下载特定的 
PLC，此时的仿真属于已组态的仿真。在这种情况下，将显示 PLC 的名称，例如 
"MyPLC [CPU 1215 DC/DC/DC]"。 

无仿真 

如果已打开应用程序但处于断电状态时，S7-PLCSIM 
被认为处于“无仿真”状态。在该状态下，电源按钮呈灰色。  

 

处于“无仿真”状态时，仍可以在项目视图中创建项目、设置 SIM 表和序列。  
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2.7.6 仿真支持的 STEP 7 程序 

S7-PLCSIM 接受为支持的已组态 CPU 
下载任何有效的程序。除了若干特例（如下注明）以外，下载的程序应直接转到 RUN 
模式，不得进行任何更改。  

在下列三种特殊情况下，需要先对 STEP 7 程序进行更改，然后才能下载到 
S7-PLCSIM。具体包括： 

● 专有技术保护。S7-PLCSIM 
不支持对受用户专有技术保护的块进行仿真。如果项目中包含受专有技术保护的块，

则仿真时需要先移除块保护，然后再将项目下载到 S7-PLCSIM。 

● 故障安全程序。S7-PLCSIM 支持故障安全程序仿真。但是，可能需要延长 F 
周期时间，因为仿真的扫描时间会比较长。 

● S7-1500 运动控制程序。S7-PLCSIM 支持对 
S7-1500 SMC（简单运动控制）组态进行仿真。但是，若要成功运行这些程序，可能

需要延长运动控制周期时间，因为仿真的扫描时间会比较长。 

2.7.7 RUN 和 STOP 模式以及仿真 

仿真的 PLC 支持在 RUN 模式下进行下载。  

将仿真的 PLC 置于 STOP 模式下时，S7-PLCSIM 会写入输出值。 

2.7.8 仿真 PLC 与“真实”PLC 之间的区别 

2.7.8.1 差异概述 

虚拟 PLC 并不能完全仿真真实 PLC。虚拟 PLC 与真实 PLC 
的行为会存在差异。差异有时候存在于所有 CPU 系列中，也有时候只存在于一个 CPU 
系列或特定 CPU 中。 

许多系统 CPU 函数（SFC 和 
SFB）用于仿真的操作是有限的。在仿真期间，依赖此函数的程序操作会发生变化。  

此外，与时间密切相关的程序会很难通过仿真进行调试，因为仿真时间不如真实 PLC 
的时间那般确切。 
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2.7.8.2 所有受支持 PLC 通用的区别 

I/O 设备支持 

S7-PLCSIM 不支持专用 I/O 模块功能。仅提供 I/O 寄存器的过程映像和直接访问仿真。  

以模拟量输出范围监视为例说明如何查看此专用功能。在实际模块上，如果将范围外的值

写入模拟量输出寄存器，则模拟量模块会出现诊断错误。S7-PLCSIM 
中会发生这种情况。物理模块执行的任何功能都不会在 S7-PLCSIM 中进行仿真。  

受专有技术保护的块 

S7-PLCSIM V14 不支持受专有技术保护或受密码保护的块。在对 S7-PLCSIM 
执行下载操作前，必须移除保护。  

基于 PC 的控制器 

S7-PLCSIM V14 不支持对基于 PC 的控制器进行仿真。  

诊断 

S7-PLCSIM 不支持写入诊断缓冲区的所有错误消息。例如，S7-PLCSIM 不仿真 CPU 
中与故障电池相关的消息或 EPROM 错误。不过，S7-PLCSIM 可仿真大多数程序错误。  

基于时间的性能 

由于 S7-PLCSIM 软件运行在装有 Windows 操作系统的 PC 上，因此 S7-PLCSIM 
中操作的扫描周期时间和确切时间不同于在物理硬件上执行那些操作所需的时间。  

如果程序高度依赖于执行操作所需的时间，则需注意不应仅根据 S7-PLCSIM 
仿真的时间结果来评估程序。 

访问保护和复制保护 

S7-PLCSIM 不会对访问保护或复制保护进行仿真。  

使 LED 闪烁 

可在 STEP 7的“扩展的下载到设备”(Extended download to device) 对话框中使 PLC 上的 
LED 灯闪烁，但 S7-PLCSIM 无法仿真此功能。   
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需要 SD 存储卡的功能 

S7-PLCSIM 不会仿真 SD 存储卡。因此，不能仿真需要存储卡的 CPU 
功能。例如，数据记录功能会将所有输出都写入 SD 卡，这样便无法仿真数据记录功能。  

数据记录 

S7-PLCSIM 不支持数据记录功能，因为该功能会将所有输出都写入 SD 卡，而 
S7-PLCSIM 不支持使用 SD 卡。  

配方 

S7-PLCSIM 不支持配方，因为配方数据存储在 SD 卡中，而 S7-PLCSIM 不支持使用 
SD 卡。  

Web 服务器 

S7-PLCSIM 不支持 Web 服务器功能。  

PROFIBUS 

如果 STEP 7 项目中包含 PROFIBUS 元素，则 S7-PLCSIM 不会仿真 PROFIBUS 
元素，但是项目中的其它部分会照常仿真。 

启动仿真之前，您无需将 PROFIBUS 元素从项目中移除。只是必须注意，S7-PLCSIM 
会忽略 PROFIBUS 元素。  

仿真运动控制 

运动控制概述 

S7-PLCSIM 支持包含 S7-1500、S7-1500C、S7-1500T、S7-1500F、ET 200SP 和 
ET 200SPF CPU 的运动控制组态和功能的 STEP 7 项目。  

 

 
说明 

S7-1200 运动控制项目 
S7-PLCSIM 不支持 S7-1200 或 S7-1200F CPU 的运动控制。 
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仿真和回原点模式 

对于真实的 CPU，直接设置回原点，状态相应地对其进行“参考”。不评估硬件输入。  

运动控制仿真限制 

请注意，如果满足以下任一条件，则仿真结果可能会受到限制：  

● 项目的周期时间非常短 

● 项目硬件组态中包含大量设备，例如驱动器 

● 项目采用了大量工艺对象，例如定位轴 

仿真行为还取决于使用的工艺对象类型。  

参见 

进入 RUN 模式后稍作等待以访问运动控制工艺对象 (页 159) 

运动控制工艺对象 
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TO_PositioningAxis 

对于 TO_PositioningAxis 工艺对象，已仿真的驱动器会为 S7-PLCSIM 
提供与位置功能相关的反馈。  

轴位置反馈 

设定值（位置）会在经过一段时间延迟后集成（PT1 元素）。该计算结果会反馈回 
TO_PositioningAxis 对象作为轴的实际位置。 

回原点轴 

如果在 STEP 7 中选择了“通过 PROFIdrive 
报文使用零位标记”的回原点模式，S7-PLCSIM 会立即响应每个主动（模式 
2、3、8）或被动（模式 4、5）回原点命令 
(MC_Home)，并将实际位置设为回原点位置。  

仿真限制 

● S7-PLCSIM 不会仿真模拟量定位轴。 

● 对于动态伺服控制 (DSC) 报文 5，可能需要在“控制回路：预控制和速度增益（Kv 
因子）”(Control loop: Precontrol and velocity gain (Kv factor)) 和/或“定位监视 > 
跟踪误差”(Positioning monitoring > Following error) 下调整 STEP 7 
设置，以得到有意义的仿真行为。以递增方式逐渐调整这些设置，直到仿真响应符合

预期要求。 

TO_ExternalEncoder 

对于 TO_ExternalEncoder 工艺对象，已仿真的外部编码器会向 S7-PLCSIM 
提供回原点命令设定的静态/固定位置反馈。  

回原点 

对于 TO_ExternalEncoder 对象不能使用主动回原点。 

如果在 STEP 7 中选择了“通过 PROFIdrive 
报文使用零位标记”的被动回原点模式，S7-PLCSIM 会立即响应每个被动（模式 
4、5）回原点命令 (MC_Home)，并将实际位置设为回原点位置。 
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运动控制的限制 

每个可分配给工艺对象的 CPU 上都具有运动控制资源。 

S7-PLCSIM 最多支持 5120 个运动控制资源。因此，下列 CPU 存在运动控制仿真限制： 
 

CPU 类型 订货号 

标准 CPU 1517-3 PN/DP 6ES7517-3AP00-0AB0 

CPU 1518-4 PN/DP 6ES7518-4AP00-0AB0 

CPU 1518-4 PN/DP ODK1 6ES7518-4AP00-3AB0 

故障安全 CPU 1517F-3 PN/DP 6ES7517-3FP00-0AB0 

CPU 1518F-4 PN/DP 6ES7518-4FP00-0AB0 

CPU 1518F-4 PN/DP ODK1 6ES7518-4FP00-3AB0 

工艺 CPU 1517T-3 PN/DP2 6ES7517-3TP00-0AB0 

CPU 1517TF-3 PN/DP2 6ES7517-3UP00-0AB0 

1 不仿真该 CPU 的 ODK 功能。 

2 该 CPU 的仿真仅支持 64 个凸轮。 

超过数量结构 

STEP 7 会检查组态的 CPU 的数量结构是否合规，并在超出时进行提醒。当向 CPU 
中加载项目时，会显示另一条消息。 

 

 
说明 
可将使用超过 5120 
个运动控制资源的项目下载到虚拟控制器中。但是，没有指示超过数量结构的消息。 
当程序访问工艺对象之后，如果已超出数量结构，则会观察到以下指示： 

• 块处的错误消息 

• 对象的值为零 
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2.7.8.3 特定于 S7-1200 PLC 的差异 

S7-1200 CPU 和固件版本兼容性 

S7-PLCSIM 只能仿真如下 S7-1200 PLCs： 

● 固件版本为 4.0 或更高版本的 S7-1200 PLCs 

● 固件版本为 4.1 或更高版本的 S7-1200F PLCs  

针对 S7-1200 故障安全 CPU 调整 STEP 7 程序设置 

要仿真 S7-1200F PLC，在向 S7-PLCSIM 执行下载之前，必须在 STEP 7 项目中调整 F 
参数 F 监视时间。这是因为基于软件的仿真和实际物理硬件间存在时间差。  

在 STEP 7 中调整 F 监视时间的步骤 

要调整 F 监视时间，请按以下步骤操作： 

1. 在 STEP 7 项目树中，右键单击 F-CPU 并选择“属性”(Properties)。 

2. 在“属性”(Properties) 对话框中，转到“故障安全 > F 参数 > 集中式 F-I/O 的默认 F 
监视时间”(Fail-safe > F-parameter > Default F-monitoring time for central F-I/O)。 

3. 将 F 监视时间从默认值 150 ms 调整为更高值。 

4. 单击“确定”(OK)。 

可能需要重复该步骤，直至找到可使 F-CPU 仿真无错运行的 F 监视值。 

工艺模块和工艺对象支持：S7-1200 

工艺模块支持 

S7-PLCSIM 不仿真以下工艺模块：  

● 计数  

● PID 控制  

● 运动控制  
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工艺对象支持 

S7-PLCSIM 目前不支持以下工艺对象：  

● 运动控制  

● PID  

指令支持：S7-1200 

S7-PLCSIM 几乎支持仿真的 S7-1200 和 S7-1200F 的所有指令，就像物理 PLC 一样。 

某些指令受部分支持。对于这些指令，S7-PLCSIM 
将验证输入参数并返回有效输出，但不一定是带有物理 I/O 的真实 PLC 
将返回的信息。例如，S7-PLCSIM 不支持 SIMATIC 
存储卡，并且在执行用于将数据日志保存到存储卡中的程序指令在时，实际上不会保存任

何数据。  

可以下载成功编译到虚拟 PLC 中的所有程序。但是，某些指令会调用受部分支持的 
SFC（系统函数）或 SFB（系统函数块）。  

支持的通信指令：S7-1200 

S7-PLCSIM 支持 S7-1200 和 S7-1200F PLC 的如下通信指令： 

● PUT 和 GET 

● TSEND 和 TRCV 

● TSEND_C 和 TRCV_C 
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2.7.8.4 特定于 S7-1500 PLC 的差异 

S7-1500 CPU 和固件版本兼容性 

S7-PLCSIM V14 支持 S7-1500、S7-1500C、S7-1500T 和 S7-1500F CPUs 
的所有固件版本。  

针对 S7-1500 故障安全 CPU 调整 STEP 7 程序设置 

要仿真 S7-1500F PLC，在向 S7-PLCSIM 执行下载之前，必须在 STEP 7 项目中调整 F 
参数 F 监视时间。这是因为基于软件的仿真和实际物理硬件间存在时间差。  

在 STEP 7 中调整 F 监视时间的步骤 

要调整 F 监视时间，请按以下步骤操作： 

1. 在 STEP 7 项目树中，右键单击 F-CPU 并选择“属性”(Properties)。 

2. 在“属性”(Properties) 对话框中，转到“故障安全 > F 参数 > 集中式 F-I/O 的默认 F 
监视时间”(Fail-safe > F-parameter > Default F-monitoring time for central F-I/O)。 

3. 将 F 监视时间从默认值 150 ms 调整为更高值。 

4. 单击“确定”(OK)。 

可能需要重复该步骤，直至找到可使 F-CPU 仿真无错运行的 F 监视值。 

工艺模块和工艺对象支持：S7-1500 

工艺模块支持 

对于 S7-1500、S7-1500C 和 S7-1500F，S7-PLCSIM 支持以下工艺模块：  

● 计数和测量  

● PID 控制  

● 基于时间的 IO  

● 运动控制  
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工艺对象支持 

对于 S7-1500、S7-1500C 和 S7-1500F，S7-PLCSIM 支持以下工艺对象：  

● 运动控制  

● PID  

● 计数和测量  

指令支持：S7-1500 

S7-PLCSIM 几乎支持 S7-1500、S7-1500C 和 S7-1500F 的所有指令，就像物理 PLC 
一样。  

某些指令受部分支持。对于这些指令，S7-PLCSIM 
将验证输入参数并返回有效输出，但不一定是带有物理 I/O 的真实 PLC 
将返回的信息。例如，S7-PLCSIM 不支持 SIMATIC 
存储卡，并且用于在存储卡上创建数据日志的指令实际上无法读写存储卡。  

可以下载成功编译到虚拟 PLC 中的所有程序。但是，某些指令会调用受部分支持的 
SFC（系统函数）或 SFB（系统函数块）。  

支持的通信指令：S7-1500 

S7-PLCSIM 支持 S7-1500、S7-1500C 和 S7-1500F PLCs 的如下通信指令：  

PUT 和 GET 

BSEND 和 BRCV  

USEND 和 URCV 

TSEND 和 TRCV 

TSEND_C 和 TRCV_C 
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2.7.8.5 特定于 ET 200SP PLC 的差异 

ET 200SP CPU 和固件版本兼容性 

S7-PLCSIM V14 支持 ET 200SP 和 ET 200SPF CPUs 的所有固件版本。  

 

针对 ET 200SP 故障安全 CPU 调整 STEP 7 程序设置 

要仿真 ET 200SPF PLC，在向 S7-PLCSIM 执行下载之前，必须在 STEP 7 项目中调整 
F 参数 F 监视时间。这是因为基于软件的仿真和实际物理硬件间存在时间差。  

在 STEP 7 中调整 F 监视时间的步骤 

要调整 F 监视时间，请按以下步骤操作： 

1. 在 STEP 7 项目树中，右键单击 F-CPU 并选择“属性”(Properties)。 

2. 在“属性”(Properties) 对话框中，转到“故障安全 > F 参数 > 集中式 F-I/O 的默认 F 
监视时间”(Fail-safe > F-parameter > Default F-monitoring time for central F-I/O)。 

3. 将 F 监视时间从默认值 150 ms 更改为更高值。 

4. 单击 OK。 

可能需要重复该步骤，直至找到可使 F-CPU 仿真无错运行的 F 监视值。  

工艺模块和工艺对象支持： ET 200SP 

工艺模块支持 

对于 ET 200SP 和 ET 200SPF，S7-PLCSIM 支持以下工艺模块：  

● 计数和测量  

● PID 控制  

● 基于时间的 IO  

● 运动控制  
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工艺对象支持 

对于 ET 200SP 和 ET 200SPF，S7-PLCSIM 支持以下工艺对象：  

● 运动控制  

● PID  

● 计数和测量  
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指令支持：ET 200SP 

S7-PLCSIM 几乎支持 ET 200SP 和 ET 200SPF 的所有指令，就像物理 PLC 一样。  

某些指令受部分支持。对于这些指令，S7-PLCSIM 
将验证输入参数并返回有效输出，但不一定是带有物理 I/O 的真实 PLC 
将返回的信息。例如，S7-PLCSIM 不支持 SIMATIC 
存储卡，并且用于在存储卡上创建数据日志的指令实际上无法读写存储卡。  

可以下载成功编译到虚拟 PLC 中的所有程序。但是，某些指令会调用受部分支持的 
SFC（系统函数）或 SFB（系统函数块）。 

支持的通信指令：ET 200SP 

S7-PLCSIM 支持 ET 200SP 和 ET 200SPF PLCs 的如下通信指令：  

PUT 和 GET 

BSEND 和 BRCV  

USEND 和 URCV 

TSEND 和 TRCV 

TSEND_C 和 TRCV_C 

2.8 使用帮助系统 

2.8.1 帮助系统概述 

在线帮助系统的内容丰富全面，详细介绍了相关特性与操作步骤，可帮助用户更为高效地

使用 S7-PLCSIM。S7-PLCSIM 帮助系统与 TIA Portal 
帮助系统的运行方式相同。它可以从主 S7-PLCSIM 
应用程序中打开一个单独的窗口，便于用户在继续工作的同时获取所需信息。 

可以通过下列方式启动在线帮助： 

● 在主菜单的“帮助”(Help) 下选择“显示帮助”(Show help) 

● 在应用程序的任意位置处单击 F1 键 
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采用电子手册格式的在线帮助 

在线帮助还提供有电子手册格式，可从以下位置获取： 

● 安装盘 

● 计算机硬盘（安装后） 

● Siemens 工业在线支持 (https://support.industry.siemens.com/cs/?lc=zh-CN)网站 

这不但使得用户能够根据格式需要而采取最合适的方式访问帮助，而且还方便打印。 

目标读者 

其中的帮助文档适用于具备以下方面知识与经验的人员：  

● 工业自动化和自动化工程 

● PLC 编程 

● SIMATIC PLC 

● STEP 7 

● TIA Portal 

S7-PLCSIM 自述文件和在线自述文件 

S7-PLCSIM V14 
附带的自述文件包含发布该产品时在线帮助中无法包含的信息。本自述文件中的信息优先

于其它文档中的信息，建议您仔细阅读。  

此外，本自述文件会根据需要进行更新，并且更新内容会在网上发布。如果在使用 
S7-PLCSIM 
时发生异常，请参考在线版本的自述文件来查看是否有解决您遇到的问题的主题。请访问 
Siemens 工业在线支持 (https://support.industry.siemens.com/cs/?lc=zh-
CN)网站并搜索“S7-PLCSIM V14 自述文件”。 

 

 
说明 

每个 S7-PLCSIM 版本都有单独的在线自述文件 
每个版本的 S7-PLCSIM 都有单独的在线自述文件，因此请确保您已定位到 
S7-PLCSIM V14 的在线自述文件而不是早期版本之一。 

 

https://support.industry.siemens.com/cs/?lc=zh-CN
https://support.industry.siemens.com/cs/?lc=zh-CN
https://support.industry.siemens.com/cs/?lc=zh-CN
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在线服务与支持 

Siemens 工业在线支持 (https://support.industry.siemens.com/cs/?lc=zh-
CN)网站上提供了所有 SIMATIC 产品及系统技术文档，在该网站可以获取如下信息：  

● 包含相关产品最新信息的新闻 

● 产品文档 

● 论坛可供全球用户和专家进行知识交流 

● 西门子工业领域产品与服务的当地联系方式 

● 有关现场服务、维修、备件等更多信息 

2.8.2 搜索帮助系统 

自 S7-PLCSIM V14 起，信息系统包含 S7-PLCSIM 帮助和 TIA Portal 
帮助。这两个帮助系统位于“目录”(Content) 选项卡下。在“目录”(Content) 选项卡下：  

● S7-PLCSIM 帮助被命名为“S7-PLCSIM 在线帮助”。 

● TIA Portal 帮助被命名为“信息系统”。 

显示搜索结果 

当您搜索信息时，结果会显示 S7-PLCSIM 帮助和 TIA Portal 帮助中与之匹配的主题。 

例如，在信息系统左侧的“搜索：”(Search for:) 
框中搜索术语“显示格式”。搜索结果将包含 S7-PLCSIM 和 TIA Portal 主题。 

如果想要仅查看 S7-PLCSIM 帮助的搜索结果，可对“位置”(Position) 
列标题进行排序，S7-PLCSIM 
帮助的搜索结果会组合在一起。这样便可确保您正在查看的全部都是 S7-PLSCIM 
搜索结果。因而您能更加轻松地确定哪个 S7-PLCSIM 
帮助主题最适合帮助您处理显示格式问题。 

https://support.industry.siemens.com/cs/?lc=zh-CN
https://support.industry.siemens.com/cs/?lc=zh-CN


S7-PLCSIM 概述  
  

 S7-PLCSIM V14 在线帮助 
40 编程和操作手册, V14, 09/2016, A5E38930223-AA 

2.8.3 自述文件和在线自述文件 

S7-PLCSIM V14 自述文件和在线自述文件提供了 S7-PLCSIM V14 
的相关使用信息（产品发售时尚未提供该信息）。 

S7-PLCSIM 自述文件 

安装 S7-PLCSIM V14 时即可获得自述文件。  

单击“阅读产品信息”(Read product information) 按钮即可在安装期间访问自述文件。  

安装产品后，可通过以下两种方式搜索自述文件进行访问： 

● 浏览到安装 S7-PLCSIM V14 的文件夹 

● 使用 Windows 开始菜单搜索框搜索硬盘上的特定文件 

每种语言都有一个对应的自述文件，如下所示： 
 

语言 文件名 

中文（简体） ReadMePE2MzhCN.chm 

英语 ReadMePE2MenUS.chm 

法语 ReadMePE2MfrFR.chm 

德语 ReadMePE2MdeDE.chm 

意大利语 ReadMePE2MitIT.chm 

西班牙语（现代） ReadMePE2MesES.chm 

S7-PLCSIM 在线自述文件 

本自述文件会根据需要进行更新，并且更新内容会以在线自述文件的形式在网上发布。  

如果在使用 S7-PLCSIM 
时发生异常，请参考在线版本的自述文件来查看是否有解决您遇到的问题的主题。请访问 
Siemens 工业在线支持 (https://support.industry.siemens.com/cs/?lc=zn-
CN)网站并搜索“S7-PLCSIM V14 自述文件”。每种语言都有一个对应的在线自述文件。 

 

 
说明 

每个 S7-PLCSIM 版本都有单独的在线自述文件 
每个版本的 S7-PLCSIM 都有单独的在线自述文件，因此请确保您已定位到 
S7-PLCSIM V14 的在线自述文件而不是早期版本之一。 

 

https://support.industry.siemens.com/cs/?lc=zn-CN
https://support.industry.siemens.com/cs/?lc=zn-CN
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启动选项 3
3.1 启动选项概述

用户可以选用多种方式来启动 S7-PLCSIM。  

以下部分详细介绍了 S7-PLCSIM 
的各种启动方式。用户可根据具体应用程序选择最合适的启动方式。

3.2 通过 TIA Portal 启动 

3.2.1 通过 TIA Portal 启动的概述 

所有仿真项目都必须通过下载操作，从 STEP 7 
项目中获得其硬件组态以及可执行的程序。直接通过 TIA Portal 启动 S7-PLCSIM 
能够非常轻松地实现上述过程。

请注意，不能在 S7-PLCSIM 中创建或编辑已组态的硬件或 STEP 7 用户程序。必须在 
TIA Portal 中更改这些组件。 

3.2.2 使用“启动仿真”命令 

在 STEP 7 中，“启动仿真”(Start simulation) 选项适用于 S7-PLCSIM 
能够仿真的设备。安装 S7-PLCSIM V14 时，将为支持的 PLC 系列（S7-1200、S7-1500 
和 ET 200SP）启用仿真选项。 

在 STEP 7 
中，可以通过主工具栏或者快捷菜单对项目树中的设备启动仿真。在设备组态视图或项目

树中选择支持的 CPU 时，将启用这些选项。 

在 S7-PLCSIM 应用程序选项设置中，可以选择 S7-PLCSIM 
的启动方式。可以选择以“精简视图”或“项目视图”启动应用程序。以下部分将探讨这项选

择的操作和含义。
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注：在之前版本的 S7-PLCSIM 中，STEP 7 的“启动仿真”(Start simulation) 
命令会先查找可使用的活动仿真。只有在未找到任何活动仿真的情况下，才会启动新的 
S7-PLCSIM 实例。对于 V14，这一点不再适用，选择“启动仿真”(Start simulation) 
时将始终启动新的 S7-PLCSIM 实例。如果要连接到已运行的 S7-PLCSIM 
实例，则应选择“下载”(Download) 命令。  

3.2.3 使用“启动仿真”命令以精简视图启动 

当在 STEP 7 中选择“启动仿真”(Start simulation) 并选择以精简视图启动 S7-PLCSIM 
时，将发生以下事件： 

● 启动一个 S7-PLCSIM 精简视图的新实例。 

● 新的 S7-PLCSIM 实例会针对所选 PLC 系列（S7-1200、S7-1500 或 
ET 200SP）启动仿真。 

● 当仿真激活时，将开始从 STEP 7 进行下载操作。 

完成下载后，可通过 STEP 7 转到在线状态以调试程序，也可以切换到项目视图以使用 
SIM 表编辑器和序列编辑器中的调试工具。 

3.2.4 使用“启动仿真”命令以项目视图启动 

当在 STEP 7 中选择“启动仿真”(Start simulation) 并选择以项目视图启动 S7-PLCSIM 
时，将发生以下事件： 

● 启动一个 S7-PLCSIM 项目视图的新实例。 

● S7-PLCSIM 会针对所选 PLC 系列（S7-1200、S7-1500 或 ET 200SP）启动仿真。 

● 当仿真激活并就绪时，将开始从 STEP 7 进行下载操作。 

完成下载后，可通过 STEP 7 转到在线状态以调试程序。 

请注意，启动 S7-PLCSIM 和启动仿真都不会自动创建 S7-PLCSIM 项目。 
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3.3 通过桌面图标或开始菜单启动 

3.3.1 通过桌面图标或开始菜单启动的概述 

可以通过桌面快捷方式或开始菜单条目以精简视图或项目视图启动 S7-PLCSIM。  

对于 V14，“启动时加载最新项目”(load most recent project during startup) 
的应用程序选项设置将不再是一个选项。  

因此，通过桌面图标或开始菜单启动时，将直接加载 
S7-PLCSIM，而不再打开项目。关于精简视图和项目视图的具体操作和可用选项，将在

本文档的其它部分进行介绍。 

3.4 通过现有 S7-PLCSIM 项目启动 

3.4.1 通过现有项目启动的概述 

可以使用之前保存的 S7-PLCSIM 项目进行仿真。S7-PLCSIM 
项目包含之前创建并保存的 SIM 
表和序列。该项目还包含之前下载到仿真中的硬件和软件组态。打开 S7-PLCSIM 
项目时，配置会自动恢复到仿真中。 

可通过下列两种方式打开现有 S7-PLCSIM 项目： 

● 通过在 Windows Explorer 中双击文件打开项目 

● 通过项目视图中的 S7-PLCSIM 主菜单或主工具栏打开项目 

3.4.2 通过双击文件名称打开项目 

可以通过双击资源管理器中的 *.sim14 
项目打开现有项目。在这种情况下，无论“启动视图”(Start view) 
的应用程序设置如何，S7-PLCSIM 始终将以项目视图启动。将发生以下事件： 

● 项目的项目视图将打开并显示 SIM 表和序列。 

● 如果项目中已保存仿真，则会启动相应系列的虚拟 PLC。 

● 如果虚拟 PLC 
之前通过下载操作进行了组态，则会在仿真正在运行时转到在线状态，并在设备组态

中显示硬件组态。 
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3.4.3 通过主菜单“项目”和主工具栏打开项目 

在项目视图中，可使用主菜单“项目”(Project) 下的“打开项目”(Open project) 
条目或者主工具栏上的“打开项目”(open project) 按钮打开项目。  

在精简视图中无法打开项目，必须切换到项目视图才能打开项目。 

3.4.4 打开 S7-PLCSIM V13 SP1 项目 

使用 S7-PLCSIM V13 SP1 创建并保存的项目可以在 S7-PLCSIM V14 
中直接打开。选择项目时会出现一个消息框，提示您必须将项目转换为 S7-PLCSIM V14 
格式（*.sim13 转换为 
*sim14）。在升级过程中，将创建一个用于升级项目的项目文件夹。完成升级后，项目正

常将随即打开。新转换的项目保存后的格式不再与 S7-PLCSIM V13 SP1 兼容。 

3.4.5 打开使用 V13 SP1 之前的版本创建的项目 

无法直接打开使用 S7-PLCSIM V13 SP1 之前的版本创建并保存的 S7-PLCSIM 
项目。要使用 S7-PLCSIM V14 打开这些项目，请按以下步骤操作： 

1. 使用 S7-PLCSIM V13 SP1 打开项目。 

2. 将项目另存为 S7-PLCSIM V13 SP1 项目。 

3. 使用 S7-PLCSIM V14 打开项目。 

3.4.6 使用现有 S7-PLCSIM 项目进行仿真和调试 

打开 S7-PLCSIM 项目后，仿真随即激活，并为 S7-PLCSIM 或 STEP 7 
中的调试工作准备就绪。 

如果打开的项目是之前用于创建仿真的项目，则只需打开该项目并将合适的 
CPU“转到在线状态”，步骤与使真实 PLC 转到在线状态的步骤相同。 

如果打开的项目不是之前用于创建仿真的 STEP 7 项目，也仍然可以使用 STEP 7 
进行调试。您可以打开一个新的 STEP 7 
项目，并选择从运行的仿真进行上传。执行这一操作时，将在 STEP 7 
项目中创建硬件组态和项目，您可以将运行的仿真转到在线状态。同样，步骤与使真实 
PLC 转到在线状态的步骤相同。 
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修改正在运行的仿真 4
4.1 修改正在运行的仿真的概述

仿真开始运行后，您仍可以将在 TIA Portal 
中做出的任何更改下载到程序或组态的硬件中。

S7-PLCSIM 接受对硬件组态的任意无错更改，前提是不对硬件的 CPU 
系列进行更改。下列示例场景举例说明了仿真的成功下载与不成功的重新组态。

示例场景：更改为同一系列的 CPU 

1. 首先下载为 CPU 1211 V4.0 (6ES7 211-1AE40-0XB0) 组态的项目硬件和软件。

2. 将硬件组态更改为 CPU 1217 V4.2 (6ES7 217-1AG40-0XB0)。

3. 然后下载硬件组态。

“真实”PLC 不支持这一场景操作。V4.0 设备将不接受下载 V4.2 组态，因为 TIA Portal 
将阻止下载。但在仿真中支持这一操作。下载对话框中将指示向仿真中执行下载。下载成

功后，您可以在设备组态视图中查看结果。

示例场景：更改为不同系列的 CPU 

不能为正在运行的仿真更改 CPU 系列。考虑以下示例场景： 

1. 首先下载为 CPU-1211 V4.0 (6ES7-211-1AE40-0XB0) 组态的项目硬件和软件

2. 将硬件组态更改为 CPU-1511 V2.0 (6ES7 511-1AK01-0AB0)。

3. 然后尝试下载硬件组态。

这一场景操作将被阻止，因为 TIA Portal 无法找到合适的下载目标。 
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4.2 仿真循环上电 
下方截屏显示了正在运行已组态的 S7-1200CPU 仿真的精简视图。 

 

请注意以下几处： 

● 电源按钮呈绿色 

● 显示了已组态的 CPU 的名称 

● 显示了通信 (IP) 地址 

● LED 处于激活状态 

● RUN、STOP 和 MRES 按钮已启用 

单击电源按钮关闭仿真后的结果如下所示： 
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请注意用户界面中哪些内容发生了变化，哪些内容未发生变化：

● 电源按钮呈灰色

● 仍显示已组态的 CPU 的名称

● 通信 (IP) 地址已移除

● LED 处于禁用状态

● RUN、STOP 和 MRES 为禁用状态

● 显示了 CPU 系列选项

停止仿真时会保存虚拟 PLC 
组态。如果再次单击电源按钮，则会使用该组态启动新仿真。其作用相当于对先前的仿真

“循环上电”。 
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4.3 更改正在仿真的 CPU 系列 
修改正在运行的仿真的另一个目的是更改正在仿真的 CPU 
系列。下方精简视图中的仿真处于停止状态： 

 

图中显示了 CPU 系列的下拉列表。单击下箭头将显示所支持的 CPU 系列的列表： 

 

如果更改 CPU 
系列后单击电源按钮，则会重新启动一个所选系列的未组态仿真。之前仿真中的组态将被

丢弃。此时将显示如下精简视图： 
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● 显示了“未组态的”CPU 的名称 

● 未显示任何通信地址 

● LED 和 RUN、STOP 和 MRES 按钮为禁用状态 

项目视图中的显示内容 

如果已创建或更改项目，项目视图会显示一个打开的 S7-PLCSIM 
项目。如果更改仿真系列并启动新仿真，项目树将更新以显示新的未组态仿真。 

4.4 已组态的仿真与未组态的仿真 
新启动的仿真属于“未组态”仿真。未组态的仿真可以接收任意网络地址处的连接请求。未

组态的仿真启动时，对于每个支持的通信协议都有一个默认地址。  

例如，未组态的 S7-PLCSIM V5.x 仿真具有以下默认地址：  

MPI=2 DP=2 Local=2 IP=192.168.0.1 ISO=08-00-12-34-56-78 

S7-PLCSIM V14 所支持的虚拟 PLC 仅支持 IP 通信。这类通信的默认地址仅为： 

IP=192.168.0.1 

当 STEP 7 请求连接特定地址处的（例如，192.168.2.34）仿真时，S7-PLCSIM 
首先会检查该地址处是否存在已组态的仿真。如果存在，则 STEP 7 连接该仿真。  

如果该地址处现不存在已组态的仿真，则驱动程序将使 STEP 7 
连接到第一个未组态的仿真。 

当未组态的仿真接收硬件下载后，S7-PLCSIM 
将识别到该仿真现已组态，不再允许连接这一特定的已组态地址处以外的仿真。 
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在精简视图中工作 5
5.1 在精简视图中工作的概述

精简视图是 S7-PLCSIM 的默认视图。它占用的计算机屏幕空间较小，而且在您使用 
STEP 7 调试程序时可以用作虚拟 PLC。 

如果更希望以项目视图启动，则可以在项目视图主菜单的“选项 > 设置”(Options > 
Settings) 下更改默认视图。  

精简视图性能增强

自 S7-PLCSIM V14 起，精简视图的功能发生了显著变化。新的精简视图用户界面设计使 
S7-PLCSIM 能够比先前版本更为快速地启动。  

在精简视图中，您将无法再执行项目操作或运行序列。必须切换到项目视图中才能使用这

些功能。

以下部分将详细介绍精简视图的新功能。

参见

精简视图用户界面 (页 52) 
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5.2 精简视图用户界面 
当通过计算机桌面以精简视图启动 S7-PLCSIM V14 
时，打开的精简视图中没有任何项目和仿真。 

该状态下的精简视图如下方的截屏所示： 

 

精简视图功能已发生变化 

自 S7-PLCSIMV14 起，精简视图的功能发生了显著变化。本次更改使 S7-PLCSIM 
以精简视图启动时能够比先前版本更为快速地启动。  

自 S7-PLCSIM V14 起，必须切换到项目视图才能执行项目操作和管理序列。 
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精简视图用户界面说明 

精简视图主要有四个部分： 

● 标题栏 

● CPU 名称 

● CPU 控制面板 

● 项目名称 

 

 

   

①  标题栏   显示 S7-PLCSIM 标志和三个控制按钮： 
• “保持在最前面”(Keep on top) 

按钮：使精简视图显示在所有其他窗口的最前面。 
• “最小化”(Minimize) 按钮：标准 Windows 功能。 
• “关闭”(Close) 按钮：标准 Windows 功能。 

②  CPU 名称   精简视图的这一部分显示虚拟 PLC 
的名称和类型。根据应用程序状态的不同，显示的文本也会有所不

同： 
• 未打开仿真 - 显示“<无仿真>”(<no simulation>) 
• 未组态仿真（未执行下载）- 显示“未组态”(Unconfigured) 
• 已组态仿真（已执行下载）- 显示分配给 CPU 的名称以及 CPU 

的类型（例如，“MyPLC [CPU 1215 DC/DC/DC]”） 
CPU 名称部分还包含“切换到项目视图”(Switch to project view) 
按钮。 



在精简视图中工作  
5.2 精简视图用户界面 

 S7-PLCSIM V14 在线帮助 
54 编程和操作手册, V14, 09/2016, A5E38930223-AA 

③  CPU 控制面板  这一部分包含精简视图的主要功能。将显示下列 LED： 
• RUN / STOP 
• ERROR 
• MAINT 
和以下按钮： 
• RUN 
• STOP 
• MRES 
只有存在激活的已组态仿真时，才会启用这些控件。  

该部分也包括仿真的 CPU 各个实例的 IP 地址。 

④  项目名称  精简视图的项目名称部分显示 S7-PLCSIM 
项目的名称（如果存在）。与之前版本不同的是，运行仿真时无需 
S7-PLCSIM 项目。如果未打开 S7-PLCSIM 
项目，该部分将显示“<无项目>”(<no project>)。如果已打开 
S7-PLCSIM 项目，则将显示项目名称。 
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5.3 在精简视图中使用存储器复位 (MRES) 
存储器复位将清除所有工作存储器，并将装载存储器内容复制到工作存储器。可以在精简

视图中使用 MRES 按钮执行存储器复位。  

存储器复位步骤 

初始状态：您正在运行一个激活的仿真。 

● 如果您处于项目视图中，则切换到精简视图。 

● 单击 MRES 按钮。 

● 虚拟 PLC 进入 STOP 模式，而不提示您确认操作。 

● STEP 7 转到离线模式。 

● STEP 7 和 S7-PLCSIM 之间的连接断开。 

● S7-PLCSIM 自动返回在线状态。 

● STEP 7 不自动转到在线状态。 

结果：M 存储器和数据块值恢复为它们的起始值。 
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在项目视图中工作 6
6.1 项目视图用户界面

6.1.1 项目视图用户界面概述

项目视图提供 S7-PLCSIM 
的全部功能。以下截屏显示了项目视图的主要组件，其中带有两个显示在水平分割窗口中

的编辑器：
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①  标题栏  显示项目路径和项目名称，以及用于切换至精简视图、将应用程序最小化、将应

用程序最大化和关闭 S7-PLCSIM 的按钮。  

②  菜单栏   显示项目命令、编辑命令、执行命令、选项设置、工具命令、窗口命令和帮助命

令的菜单。  

③  工具栏  显示项目命令、编辑命令、执行命令、切换至精简视图、窗口命令、记录工具命

令和仿真 PLC 的 IP 地址的按钮。  

④  项目树  显示项目名称、仿真 PLC 类型以及到设备组态、SIM 表及序列的导航。  

⑤  编辑器窗口  显示设备组态的编辑器、SIM 表和序列。可以同时水平或垂直显示两个编辑器。  

⑥  带进度显示的

编辑器栏/状态

栏 

 显示用于打开编辑器的快捷键和仿真 PLC 的状态。  

从项目视图切换至精简视图 

可以通过单击主工具栏上的“切换到精简视图”(Switch to Compact view) 
按钮，从项目视图切换到精简视图。 

6.1.2 S7-PLCSIM 菜单栏 

6.1.2.1 S7-PLCSIM 菜单栏 

下图显示了 S7-PLCSIM 主菜单的用户界面，后面的表介绍了菜单的各个部分：  

 

 

菜单 说明 

项目 包含用于新建项目、打开现有项目、关闭、删除和保存项目以及退出 S7-PLCSIM 
的各种命令。还包括最近打开的项目列表。  

编辑 包含用于打开、剪切、复制、粘贴、删除和重命名仿真项目中的对象的命令。还可以查看

仿真项目的属性，包括项目名称、创建时间、项目的最后一次更改时间和项目存储路径。

还可以输入作者姓名和项目注释。  

执行 将仿真的 PLC 切换至 RUN 模式或 STOP 模式。  
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菜单 说明 

选项 打开设置对话框以便调整应用程序设置。  

窗口 允许自定义工作区。  

帮助 打开帮助系统，提供指向 Siemens 
工业在线支持网站的链接，并显示已安装软件的详细信息。  

6.1.2.2 S7-PLCSIM 菜单栏命令 

S7-PLCSIM“项目”菜单命令 

“项目”菜单包含如下命令：  

 

 
 

菜单文本 说明 

新建 创建新项目和新的仿真 
PLC。如果当前项目包含未保存的更改，系统将提示用户保存项

目。 

S7-PLCSIM 会自动将名称“Project(n).sim14”分配给新项目，其中 
(n) 
是创建的项目可用的下一个编号。如果需要，可以在“项目”(Projec
t) 属性中更改项目名称。 

打开 选择现有项目并打开。  

关闭 关闭当前仿真项目。如果当前项目包含未保存的更改，系统将提

示用户保存项目。  
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菜单文本 说明 

保存 使用当前路径和文件名保存仿真项目。  

从 STEP 7 下载时会禁用“保存”。  

它在“启动仿真”(Start simulation) 
后也会禁用。必须对新打开的仿真项目使用“另存为...”(Save as...) 
命令，然后才能使用“保存”(Save) 命令。 

另存为... 以新名称和/或新路径保存项目。从 STEP 7 
下载时会禁用“另存为...”(Save as...)。 

删除项目 选择项目并删除。 

<近期项目列表> 该应用程序保留了最近保存的仿真项目的列表。可从中单击一个

项目并打开。如果当前项目包含未保存的更改，系统将提示用户

在打开所选项目之前保存该项目。 

退出 关闭仿真的 PLC 和 S7-PLCSIM 
应用程序。如果当前项目包含未保存的更改，系统将提示用户保

存项目。 
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S7-PLCSIM“编辑”菜单命令 

“编辑”功能如下所示：  

 

 
 

菜单文本 说明 

打开对象 当可打开对象具有应用程序焦点时，将启用该菜单项。也就是说焦点

位于项目树中，且选择了其中一个元素： 

• 仿真的 PLC 

• SIM 表 

• 序列 

剪切 标准剪贴板剪切功能。可以根据当前选择启用或禁用剪切。 

复制 标准剪贴板复制功能。可以根据当前选择启用或禁用复制。 

粘贴 标准剪贴板粘贴功能。可以根据当前选择启用或禁用粘贴。 

删除 标准删除功能。可以根据当前选择启用或禁用删除。 

重命名 可以重新命名所选对象。选择下列某个项目树元素时会启用重命名： 

• SIM 表 

• 序列 

属性 显示项目的属性，包括项目名称、创建时间、项目的最后一次更改时

间和项目存储路径。还可以输入作者姓名和项目注释。 
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S7-PLCSIM“执行”菜单命令 

“执行”功能如下所示：  

 

 
 

菜单文本 说明 

启动 CPU  将仿真的 PLC 切换至 RUN 模式。只有在仿真的 PLC 处于 STOP 
模式时，才可以启用“启动 CPU”(Start CPU) 按钮。  

停止 CPU  将仿真的 PLC 切换至 STOP 模式。只有在仿真的 PLC 处于 RUN 
模式时，才可以启用“停止 CPU”(Stop CPU) 按钮。 

S7-PLCSIM“选项”菜单命令 

“选项”(Options) 部分仅包含一个命令：  

 

 
 

菜单文本 说明 

设置 可以更改工作区的外观和操作。  

应用程序设置 

应用程序设置用于自定义 S7-PLCSIM 
的操作。例如，可以选择是否显示自动级联的工具提示，或是否更改项目的默认存储位置

。  

可组态设置的完整列表如下： 
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常规设置 
 

项 设置 说明 

应用程序设

置 
用户名  新建项目时，此用户名将自动保存在项目属性中

。默认为 Windows 
用户名。如果需要，可以在此处更改名称。 

用户界面语言  可在此处更改用户界面语言。默认设置为英语。  

助记符  可以指定编程助记符： 

• “德语”使用德语助记符；例如“E1.0” 

• “国际”使用国际助记符；例如“I1.0” 

显示最近使用的项目列

表  
使用此选项可更改“主菜单 > 项目”(Main Menu > 
Project) 
下列出的最近使用项目数。默认设置为八个。  

在工具提示中自动打开

级联  
通过此复选框，可以显示或隐藏工具提示的展开

（级联）信息。该框将被选为默认设置。如果清

除该复选框，仍可使用帮助系统获取其它信息。 

启动视图 项目视图 如果要始终以项目视图启动 
S7-PLCSIM，则选择该选项。 

精简视图 默认情况下选中此选项。S7-PLCSIM 
以精简视图启动。 

重置为默认

设置 
所有应用程序设置 单击“重置为默认设置”(Reset to default) 

以返回原始应用程序设置。 

编辑器布局 单击“重置为默认设置”(Reset to default) 以仅使 
SIM 
表和序列编辑器返回到其原始应用程序设置。 
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项 设置 说明 

存储设置 最近使用的存储位置  可以选择该选项或“默认存储位置”(Default 
storage location) 
选项。如果选择了“最近使用的存储位置”(Recentl
y used storage location) 
按钮，所有打开的项目都将保存在上一个项目保

存的位置。 

默认存储位置  可以选择该选项或“最近使用的存储位置”(Recentl
y used storage location) 
选项。如果选择“默认存储位置”(Default storage 
location)，您的项目会保存在“项目的存储位置”(
Storage location for projects) 下所列出的路径。 

项目存储位置： 选择“默认存储位置”(Default storage location) 
后启用。您可以通过输入路径或浏览到所要使用

的文件夹来更改存储位置。  

循环时间监

视 

 

（请注意，

对周期时间

相关设置的

更改会立即

反映在仿真

的 PLC 
中） 

使用下载的最大周期时

间  
选择此选项，使用项目中从 STEP 7 
下载的最大周期时间。 

禁用扫描周期监视 选择此选项可防止出现循环事件溢出错误。 

指定最大循环周期 要更改最大周期时间，请选择此选项，然后在“最
大周期时间”(Maximum cycle time) 
框中输入新的时间。 

最大周期时间 如果选择了“指定最大的周期时间”(Specify 
maximum cycle 
time)，则在此框中输入新的最大周期时间。可接

受的范围为 150 ms 到 60000 ms（1 分钟）。 
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S7-PLCSIM“工具”菜单命令 

“工具”菜单包含如下命令： 

 

 
 

菜单文本 说明 

开始记录 启动 SIM 表编辑器或设备组态的“地址”部分的记录操作。 

停止记录 停止记录 SIM 
表编辑器或设备组态的“地址”部分的操作，然后通过项目树中

的记录新建一个序列。 

暂停记录 暂停记录。 
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S7-PLCSIM“窗口”菜单命令 

通过窗口功能，可以自定义工作区以符合特定需求，并将应用切换到精简视图。  

 

 
 

菜单文本 说明 

全部关闭 关闭所有打开的编辑器窗口。 

全部最小化 最小化所有打开的编辑器窗口。编辑器仍处于激活状态，且可通过

编辑器框架中的图标来使用。 

精简视图  将应用程序切换到精简视图。S7-PLCSIM 主视图被隐藏。 

下一个编辑器 用于在打开的编辑器窗口之间切换。打开的编辑器以打开的先后顺

序排列。如果只打开一个编辑器，则会禁用“下一个编辑器”(Next 
editor)。 

上一个编辑器 用于在打开的编辑器窗口之间切换。打开的编辑器以打开的先后顺

序排列。如果只打开一个编辑器，则会禁用“上一个编辑器”(Previou
s editor)。 

垂直分割编辑器

空间  
创建一个垂直分割的工作区，从而可以同时查看两个编辑器窗口。 

水平分割编辑器

空间 
创建一个水平分割的工作区，从而可以同时查看两个编辑器窗口。 

取消分割编辑器

空间 
将垂直或水平分割的工作区恢复为单个编辑器窗口。 
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S7-PLCSIM“帮助”菜单命令 

“帮助”功能如下所示：  

 

 
 

菜单文本 说明 

显示帮助  打开帮助系统。  

Internet 
上的服务与支持 

提供到 Siemens 工业在线支持网站的链接。  

已安装的软件  显示已安装的 Siemens 软件的相关信息，包括 S7-PLCSIM 和 
TIA Portal 的版本号。 
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6.1.3 S7-PLCSIM 工具栏 

6.1.3.1 S7-PLCSIM 工具栏 

S7-PLCSIM 工具栏的功能与主菜单相同，而且还具有电源开/关和 CPU 系列选择功能：  

 

工具栏上从左到右的图标所代表的命令如下： 
 

功能 简述 

项目命令按钮 • 新建项目 

• 打开现有项目 

• 保存项目 

编辑命令按钮 • 剪切 

• 复制 

• 粘贴 

• 删除 

电源按钮和 CPU 
系列选择器 

• 为 CPU 供电或断电 

• 选择或更改 CPU 系列 

执行命令按钮 • 将 CPU 置于 RUN 模式 

• 将 CPU 置于 STOP 模式 

撤消和恢复命令按钮 • 撤消上一个动作 

• 恢复上一个撤消动作 

记录/播放命令按钮 • 记录 

• 停止 

• 暂停 

窗口命令按钮 • 切换到精简视图 

• 水平分割界面 

• 垂直分割界面 

切换视图按钮 • 切换到精简视图 
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6.1.3.2 S7-PLCSIM 工具栏对象 

S7-PLCSIM 工具栏项目按钮 

主工具栏上的项目操作如下：  

 

从左到右，这些操动可执行以下功能： 
 

功能 说明 

新建项目 创建新项目。  

如果当前项目包含未保存的更改，系统将提示用户保存项目。  

S7-PLCSIM 会自动将名称“Project(n).sim14”分配给新项目，其中 (n) 
是创建的项目可用的下一个编号。如果需要，可以更改项目名称。  

打开项目 导航至希望打开的项目。如果当前项目包含未保存的更改，系统将提

示用户保存项目。  

保存项目 使用当前路径和文件名将仿真项目另存为“.sim14”文件。从 STEP 7 
下载时无法保存项目。  

S7-PLCSIM 工具栏编辑按钮 

主工具栏上的编辑功能如下：  

 

从左到右，这些图标可执行以下操作： 
 

项 说明 

剪切 用于所选对象的标准 Windows 剪贴板剪切功能。  

复制 用于所选对象的标准 Windows 剪贴板复制功能。 

粘贴 用于所选对象的标准 Windows 剪贴板粘贴功能。 

删除 用于所选对象的标准 Windows 删除功能。 

S7-PLCSIM 工具栏电源按钮和 CPU 系列选择器 

主工具栏上的电源开/关按钮和 CPU 系列选择器如下所示：  
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从左到右，这些对象可执行以下功能： 
 

功能 说明 

电源开/关按钮 为 CPU 供电和断电。供电时，该按钮呈绿色；断电时，该按钮呈灰色。  

CPU 
系列选择器 

允许选择要仿真的 PLC 的 CPU 系列。  

S7-PLCSIM 工具栏 CPU 执行按钮 

主工具栏上提供的执行功能如下：  

 

从左到右，这些图标可执行以下功能： 
 

功能 说明 

RUN 存在活动仿真项目时，将仿真的 PLC 切换至 RUN 模式。  

STOP 存在活动仿真项目时，将仿真的 PLC 切换至 STOP 模式。  
 

 

 
说明 

RUN/STOP 指示灯 
在某些情况下，S7-PLCSIM 中的 RUN/STOP 
指示器会显示错误信息，或者可能被错误禁用。发生这种情况时，请使用 STEP 7 
中的等效控件更改仿真的 CPU 的模式。 

 

S7-PLCSIM 工具栏窗口按钮 

主工具栏窗口部分中提供的操作如下：  

 

从左到右，这些图标可执行以下功能： 
 

功能  说明 

水平分割编辑器空间 水平分割工作区，可同时查看两个编辑器窗口。  

垂直分割编辑器空间 垂直分割工作区，可同时查看两个编辑器窗口。  

精简视图 从项目视图切换至精简视图。 
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S7-PLCSIM 工具栏记录/播放按钮 

工具栏按钮“记录”(Record)、“停止”(Stop) 和“暂停”(Pause) 可用于记录和保存 SIM 
表编辑器或设备组态“地址”(Addresses) 
部分中的一系列操作，然后使用序列进行重新播放。  

 

从左到右，这些图标可执行以下功能： 
 

功能  说明 

开始记录  开始记录 SIM 表或设备组态“地址”(Addresses) 
部分中的操作。 

停止记录 停止记录 SIM 
表编辑器或设备组态的“地址”部分的操作，然后通过项目树中

的记录新建一个序列。 

暂停记录 暂停记录。 
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S7-PLCSIM 工具栏撤消和恢复按钮 

工具栏按钮撤消和恢复使您能够撤消和恢复某些动作。  

 

从左到右，这些按钮可执行以下功能：  
 

功能  说明 

撤消 使您能够撤消某些动作。  

恢复 使您能够恢复之前撤消的动作。 

6.1.4 项目树说明 

S7-PLCSIM 项目树的设计和操作与 STEP 7 
中的项目树类似。树中的顶层文件夹表示项目。项目包含下载的 PLC、设备组态、SIM 
表和序列。  

 

 

项目树中的节点包含以下内容：  

项目[n] 

项目文件夹：显示仿真项目的当前名称。默认项目名称为“Project[n]”，其中 [n] 
是可用于名称分配的下一个递增的数字。例如，第一个 S7-PLCSIM 
项目的默认名称为“Project1”。项目文件夹包含设备（下载的 PLC）。 
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PLC_n [SIM-"CPU"] 

PLC 文件夹：它显示 STEP 7 中组态的仿真 PLC 以及特定 PLC 的名称。 

执行从 STEP 7 进行下载的操作前，PLC_n [SIM-"CPU 系列"] 
将一直显示。下载后，将显示所选的特定 PLC 的名称（例如，“PLC_1 [CPU 1516-3 
PN/DP”]）。  

● 设备组态：此节点显示从 STEP 7 下载的设备组态。  

SIM 表文件夹 

一个项目可包含多个 SIM 表。此文件夹为项目的 SIM 表分组。  

● 添加新 SIM 表：单击此节点为项目添加 SIM 表。S7-PLCSIM 
将新建具有唯一默认名称的 SIM 表，并在 SIM 表编辑器中显示新的空 SIM 
表。可以通过右键单击表名称并选择“重命名”(Rename) 来更改名称。 

● SIM table_1：默认情况下，新项目包含单个 SIM 表，默认名称为“SIM 
table_1”，因此可以立即进入该表并监视地址。可以通过右键单击 SIM 
表名称并选择“重命名”(Rename) 来更改名称。  

序列文件夹 

此文件夹包含项目的序列。一个项目可包含多个序列。  

● 添加新顺序：单击此节点为项目添加序列。S7-PLCSIM 
自动为新序列指定一个唯一的默认名称，并在序列编辑器中显示新的空序列。可以通

过右键单击序列名称并选择“重命名”(Rename) 来更改名称。 

● Sequence_1：默认情况下，新项目包含单个序列，名为“Sequence_1”。可以通过右

键单击序列名称并选择“重命名”(Rename) 来重命名序列。 
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6.1.5 应用程序设置 

6.1.5.1 设置概述 

在项目视图中，可以从主菜单中选择“选项 > 设置”(Options > 
Settings)，根据用户偏好设置 S7-PLCSIM。这些设置允许您根据环境和程序自定义 
S7-PLCSIM。 

设置编辑器包括： 

● 应用程序设置 

● 启动视图 

● 重置为默认设置 

● 存储设置 

● 周期时间设置 

6.1.5.2 应用程序设置 

 

通过应用程序设置，可以更改默认用户名、用户界面语言、助记符，选择您最近使用的项

目数量，是否自动打开工具提示级联，以及是否确认在已组态 CPU 精简视图中退出 
S7-PLCSIM。 
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6.1.5.3 启动视图 

 

可以在此处选择 S7-PLCSIM 的启动方式。可以选择以精简视图或项目视图启动 
S7-PLCSIM。 

安装时的默认设置为精简视图。 

6.1.5.4 重置为默认设置 

 

通过这些选项可以复位应用程序设置。这些按钮和 TIA Portal 中提供的按钮相同。 

6.1.5.5 存储设置 

 

可以在此处选择新项目的存储路径。这些按钮和 TIA Portal 中提供的按钮相同。 
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6.1.5.6 周期时间设置 

 

S7-PLCSIM 提供周期时间选项，方便您调整特定 PC 的时间。如果使用的 PC 
运行较慢或版本较早，可以禁用周期时间监视，或调整最大周期时间。 

启动 S7-PLCSIM 时，会将周期时间设置发送给仿真的 PLC。仿真的 PLC 
在整个仿真操作期间都将使用该值。  

可接受的周期时间范围为 150 ms 到 60000 ms（0.15 秒到 1 分钟）。  

周期时间监视的默认设置为“禁用扫描周期监视”(Disable scan cycle 
monitoring)。最大周期时间的默认设置是 150 ms。 

6.1.5.7 在应用程序设置中撤消/恢复 

应用程序设置编辑器不支持撤消/恢复。这一点同样适用于 TIA Portal。 



 在项目视图中工作 
 6.1 项目视图用户界面 

S7-PLCSIM V14 在线帮助 
编程和操作手册, V14, 09/2016, A5E38930223-AA 77 

6.1.6 管理工作区 

可以自定义 S7-PLCSIM 工作区，以符合用户喜欢的工作风格，这与其它众多 Windows 
应用程序中的功能一样：  
 

 

  

  

可以拖动项目树右侧的栏以显示更多信息。 

  

 

  

可以选择“折叠”(Collapse) 或“自动折叠”(Collapse 
automatically) 来折叠项目树。 

 
  

可以改变 SIM 表和序列中的列大小。 

  

 

  

可打开和关闭应用程序的各个部分，具体方法是在项目树中对

其进行单击或在状态栏中打开和关闭各部分。 

  

 

  

可将工作区垂直或水平拆分以同时显示两个工作区域。 

  

 

  

窗口可浮动。 

 

可以从主菜单中选择“选项 > 设置”(Options > Settings) 来进一步自定义工作区。 

如果垂直或水平拆分画面，则每个窗格均包含“固定”图标  或“取消固定”图标 
。单击“固定”图标便可在查看其中一个窗格中的对象时，使另一个窗格保持不变。例如，

如果存在多个序列，则可固定其中的一个序列，以使其在您循环通过已取消固定的窗格中

的其它序列时可见。通过在已取消固定的窗格中单击 
Ctrl+F6，可使您在序列（或您想浏览的任何其它工作区域）之间循环。  

如果重新定位编辑器窗口或调整其大小，则可通过单击每个编辑器右上角的“保存窗口设

置”(Save window settings) 按钮  来保存新的布局。 
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6.1.7 快捷键 

下表列出了可以在 S7-PLCSIM 中使用的 Windows 键盘快捷键：  
 

快捷键 TIA 
Portal/S7-
PLCSIM 

MS 
Windows 

行为 

ALT √  激活或取消激活菜单栏模式 

ALT+0-9  √ 保留用于通过数字键盘输入 ASCII 码 

ALT+A-Z  √ 保留用于打开菜单 

ALT+CTRL+左箭

头 
√  上一个打开的编辑器 

ALT+CTRL+右箭

头 
√  下一个打开的编辑器 

ALT+ESC  √ 激活下一个应用程序 

ALT+F4 √  关闭应用程序 

ALT+F7 √  在精简视图和项目视图之间切换 

ALT+PRINT 
SCREEN 

 √ 将活动窗口的图像复制到剪贴板上 

ALT+SHIFT+A-Z  √ 保留用于打开菜单 

ALT+SHIFT+ESC  √ 激活上一个应用程序 

ALT+SHIFT+TAB  √ 切换到上一个应用程序用户必须在按

下 TAB 键的同时按住 ALT+SHIFT 键 

ALT+SPACE BAR  √ 打开应用程序主窗口的窗口菜单 

ALT+TAB  √ 切换到下一个应用程序 

应用程序键  √ 打开快捷菜单 

CTRL+0  √ 缩放 100% 

CTRL+1 √  打开/关闭 PNV 

CTRL+A √  全选 

CTRL+ALT+DELE
TE 

 √ 激活窗口安全对话框 

CTRL+ALT+TAB  √ 在 Vista 上切换到 Aero 风格 

CTRL+C √  复制 
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快捷键 TIA 
Portal/S7-
PLCSIM 

MS 
Windows 

行为 

CTRL+下箭头 √  向下跳转 

CTRL+END √  转到最后位置 

CTRL+ESC  √ 激活开始菜单 

CTRL+F12 √  水平分割编辑器 

CTRL+F4 √  关闭激活的编辑器 

CTRL+F6 √  下一个打开的编辑器 

CTRL+HOME √  转到最开始位置 

CTRL+INSERT √  复制 

CTRL+NUM- √  缩小 

CRL+NUM+ √  放大 

CTRL+O √  打开现有项目 

CTRL+RETURN √  多行文本框：插入分行符而无需确认 

网格编辑器：在当前行上方插入行 

CTRL+S   保存 

CTRL+SHIFT+ES
C 

 √ 激活任务管理器 

CTRL+SHIFT+F4 √  关闭所有编辑器 

CTRL+SHIFT+F6 √  上一个打开的编辑器 

CTRL+SHIFT+K √  屏幕键盘 

CTRL+SHIFT+右
箭头 

√  向右选择（取决于上下文） 

CTRL+SHIFT+S √  另存为 

CTRL+空格+鼠标

套索 
√  缩放所选区域 - 设备组态 

CTRL+上箭头 √  向上跳转 

CTRL+V √  粘贴 

CTRL+W √  关闭项目 

CTRL+X √  剪切 

DELETE √  删除 
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快捷键 TIA 
Portal/S7-
PLCSIM 

MS 
Windows 

行为 

DOWN √  下移 

END √  转到结束位置 

ESC √  停止/取消当前任务或搜索，关闭对话

框或下拉列表 

F1 √  从大部分用户界面区域启动应用程序

帮助系统 

F12 √  垂直分割编辑器 

F2 √  重命名（PNV，网格） 

F4 √  打开下拉菜单 

F6 √  按从上到下的顺序切换 WB 
的基本框架 

HOME √  转到开始位置 

INSERT √  在插入模式和覆盖模式之间切换 

LEFT √  左移 

PAGE DOWN √  向下滚动一页 

PAGE UP √  向上滚动一页 

PRINTSCREEN  √ 将屏幕图像复制到剪贴板上 

RIGHT √  右移 

SHIFT+DELETE √  剪切 

SHIFT+下箭头 √  增加选择 

SHIFT+F1 √  从大部分用户界面区域启动应用程序

帮助系统 

SHIFT+F10 √  打开快捷菜单 

SHIFT+HOME √  增加选择 

SHIFT+INSERT √  粘贴 

SHIFT+左箭头 √  增加选择 

SHIFT+PAGE 
DOWN 

√  增加选择 

SHIFT+PAGE UP √  增加选择 



 在项目视图中工作 
 6.2 在项目视图中使用撤消和恢复 

S7-PLCSIM V14 在线帮助 
编程和操作手册, V14, 09/2016, A5E38930223-AA 81 

快捷键 TIA 
Portal/S7-
PLCSIM 

MS 
Windows 

行为 

SHIFT+RETURN √  多行文本框：插入分行符而无需确认 

SHIFT+右箭头 √  增加选择 

SHIFT+TAB √  向后跳转 

SHIFT+上箭头 √  增加选择 

UP √  上移 

WINDOWS 键  √ 激活启动按钮菜单 

6.2 在项目视图中使用撤消和恢复 

6.2.1 撤消和恢复的概述 

S7-PLCSIM 支持通过“撤消和恢复”来执行多种编辑操作，操作方法与 TIA Portal 
中相同。 

使用工具栏按钮  进行撤消，  按钮进行恢复。 

也可以使用以下标准 Windows 快捷键组合：  

● 使用 Ctrl+Z 进行撤消 

● 使用 Ctrl+Y 进行恢复 

以下部分将详细介绍用户界面区域、支持撤消/恢复的操作以及明确说明不支持撤消/恢复

的操作。 

6.2.2 清空撤消/恢复队列 

以下操作将清空撤消/恢复队列： 

● 保存 S7-PLCSIM 项目 

● 关闭 S7-PLCSIM 项目 

● 下载 STEP 7 程序 

打开每个项目时，撤消队列均为清空状态。执行可撤消操作之前，撤消选项将保持禁用状

态。 
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每个 S7-PLCSIM 实例都有自己的撤消/恢复队列。打开两个 S7-PLCSIM 
实例时，这两个实例彼此独立，在两者中执行的操作不会相互影响。 

当 S7-PLCSIM 处于项目视图中且未打开项目时，将不存在可撤消的操作。 

当进行的编辑可撤消时，这些编辑将被添加到撤消队列中。只有当上一次操作为撤消操作

时才能使用恢复选项。  

如果选择撤消多个操作，则这些操作都将列在恢复队列中。但是，一旦进行新的编辑（新

的、不可撤消的操作），S7-PLCSIM 便会清空恢复队列，然后禁用恢复选项。 

6.2.3 撤消和恢复之间的相互作用 

当进行的编辑不可撤消时，这些编辑将被添加到撤消队列中。  

“恢复”选项只有在选择撤消某个操作后才可用。如果选择撤消多个操作，则这些操作都将

列在恢复队列中。  

但是，一旦进行新的编辑（新的、不可撤消的操作），S7-PLCSIM 
便会清空恢复队列，然后禁用恢复选项。 

只有当上一个操作为撤消操作时才能使用恢复选项。 
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6.2.4 在主项目视图窗口中使用撤消和恢复 

下表列出了项目视图中支持撤消/恢复的操作。“撤消/恢复描述”列是工具栏按钮的下拉列

表中所显示的文本。 
 

用户操作 撤消/恢复描述 说明 

主菜单选项： 

• “编辑 > 剪切”(Edit > 
Cut) 

• “编辑 > 复制”(Edit > 
Copy) 

• “编辑 > 粘贴”(Edit > 
Paste) 

相关工具栏按钮： 

• “剪切”(Cut) 按钮 

• “复制”(Copy) 按钮 

• “粘贴”(Paste) 按钮 

插入“名称”(name) 这些选项用于复制/粘贴项目组件（SIM 
表和序列）。可撤消操作为粘贴新组件。 
该操作还允许复制/粘贴在编辑器中选择的内容（选择

的行）。为此，撤消/恢复描述应当和特定编辑器中关

于这些操作的定义内容相匹配。 

主菜单选项： 

• “编辑 > 删除”(Edit > 
Delete) 

相关工具栏按钮： 

• “删除”(Delete) 按钮 

删除“名称” 该选项支持删除项目组件（SIM 表和序列）。 
还支持删除在编辑器中选择的内容（选择的行）。为此

，撤消/恢复描述应当和特定编辑器中关于这些操作的

定义内容相匹配。 

主菜单选项：  

“编辑 > 重命名”(Edit > 
Rename) 

重命名“名称” 该选项支持重命名项目组件（SIM 表或序列）。 

从项目树“添加新 SIM 
表”(Add new SIM table) 

添加新“名称”  

从项目树“添加新序列”(A
dd new sequence) 

添加新“名称”  

重命名项目树中的项目组

件（SIM 表或序列） 
重命名“名称”  

删除项目树中的项目组件 删除“名称”  
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下表列出了项目视图中不支持撤消/恢复的操作。 
 

用户操作 说明 

主菜单“项目”(Project) 
中的所有操作 

相关工具栏按钮： 

• “新建项目”(New project) 按钮 

• “打开项目”(Open project) 按钮 

• “保存项目”(Save project) 按钮 

项目操作不支持撤消/恢复。 

主菜单选项： 

• “编辑 > 打开对象”(Edit > Open 
object) 

在项目视图之间切换不可撤消。 

主菜单选项： 

• “执行 > 启动 CPU”(Execute > 
Start CPU) 

• “执行 > 停止 CPU”(Execute > 
Stop CPU) 

相关工具栏按钮： 

• “将 CPU 置于 RUN 
模式”(Place CPU in Run 
mode) 按钮 

• “将 CPU 置于 Stop 
模式”(Place CPU in Stop 
mode) 按钮 

这些选项为在线操作。 
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用户操作 说明 

主菜单： 

• “工具 > 开始记录”(Tools > 
Start recording) 

• “工具 > 停止记录”(Tools > 
Stop recording) 

• “工具 > 暂停记录”(Tools > 
Pause recording) 

相关工具栏按钮： 

• “开始记录”(Start recording) 
按钮 

• “停止记录”(Stop recording) 
按钮 

• “暂停记录”(Pause recording) 
按钮 

记录操作不可撤消。 

主菜单中的所有操作： 

• “窗口”(Window) 

相关工具栏按钮： 

• “切换到精简视图”(Switch to 
Compact view) 按钮 

• “水平拆分编辑器…”(Split 
editor horizontally…) 按钮 

• “垂直拆分编辑器…”(Split 
editor vertically…) 按钮 

窗口操作不可撤消。 

主菜单“帮助”(Help) 中的所有操作  

从项目树或应用程序框架中切换编

辑器 
在 SIM 表和序列编辑器之间进行的切换不可撤消。 

6.2.5 在项目视图“主菜单 > 选项 > 设置”(Main menu > Options > Settings) 
下执行撤消和恢复操作 

“主菜单 > 选项 > 设置”(Main menu > Options > Settings) 
下的操作均不支持撤消和恢复操作。TIA Portal 同样如此。 
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6.3 处理项目 
S7-PLCSIM 将所有项目数据保存在唯一的项目文件夹中。每个 S7-PLCSIM 
项目存储下列信息：  

● 从 STEP 7 下载的硬件配置 

● 从 STEP 7 下载的程序 

● S7-PLCSIM SIM 表和序列 

创建项目 

要新建项目，请从项目视图的主菜单或主工具栏或者从精简视图的工具栏转至“项目 > 
新建”(Project > New)。  

S7-PLCSIM V14 项目的文件扩展名为“.sim14”。  

默认情况下，新建项目中包含一个名为“SIM table_1”的 SIM 
表以及一个名为“Sequence_1”的序列。如果需要，可重新命名这些表。 

命名项目 

S7-PLCSIM 
会自动为项目创建一个唯一的通用名称，如“Project23.sim14”。可以将一个项目重命名，

但要确保新名称是唯一的。  

存储项目 

新建项目之后，S7-PLCSIM 
会自动为项目推荐一个存储位置。右键单击项目树中的项目名称并选择“属性”(Properties)
，可查看项目的当前存储位置。  

要更改默认项目存储位置，请按以下步骤执行：  

1. 转到主菜单的“选项 > 设置”(Options > Settings)。 

2. 在“存储设置”(Storage settings) 区域选中“默认存储位置”(Default storage location) 
复选框。 

3. 输入存储路径，或浏览到相应位置并加以选择。 

4. 完成后单击“确定”(OK) 按钮。 
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打开项目 

选择“项目 > 打开”(Project > Open) 
以打开现有项目。可以从近期项目列表中选择项目，或浏览到希望打开的项目。  

 

 
说明 

S7-PLCSIM 的版本和项目 
您可以从 S7-PLCSIM V14 中打开 S7-PLCSIM V13 SP1 
项目。执行这一操作时，该项目将被转换为 S7-PLCSIM V14 项目。 
不能使用 S7-PLCSIM V13 或 S7-PLCSIM V13 SP1 打开 S7-PLCSIM V14 项目。  

 

保存项目 

要以当前名称和存储位置保存项目，请转到“项目 > 保存”(Project > Save) 或“项目 > 
另存为...”(Project > Save 
as...)。可以接受默认名称和位置，或在保存之前更改名称和/或位置。 

 

 
说明 

STEP 7 下载期间进行保存 
从 STEP 7 进行下载操作时不能保存项目，因为“保存”(Save) 和“另存为...”(Save as...) 
在完成下载之前处于禁用状态。 

 

打开已保存的项目 

打开已保存的项目时，其组态与保存时相同，包括硬件组态和 STEP 7 程序、SIM 
表、序列以及工作区布局。  

删除项目 

要删除一个项目，请选择“项目 > 删除项目”(Project > Delete 
project)，然后选择想要删除的项目。 

也可以使用 Windows 资源管理器浏览至项目的存储位置并在此删除项目。 
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项目属性 

要查看项目属性，请在项目树中右键单击项目名称并选择“属性”(Properties)。  

项目属性对话框会按以下方式显示项目信息： 
 

类别 字段 说明 

项目 名称 当前项目名称。 

创建时间 项目创建的日期和时间。 

上一次更改 项目最后修改的日期和时间。 

作者 项目作者。默认为 Windows 用户名。 

注释 可在此处添加项目注释。 

详细信息 存储位置 项目存储位置的路径。 

大小 (KB) 项目大小 (KB)。 

可以通过覆盖默认名称来编辑“作者”(Author) 字段。 

如果需要，可以在“注释”(Comment) 字段中添加有关项目的注释。 

其它字段中的信息均不能进行更改。 
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6.4 项目视图：仿真和项目状态 

6.4.1 仿真和项目的操作相互独立 

自 S7-PLCSIM V14 起，创建项目和启动仿真是两个相互独立的操作： 

● 打开、创建、编辑、保存或删除项目。必须在项目视图下才能执行这些操作。 

● 启动仿真。既可以从项目视图启动仿真，也可以从精简视图启动仿真。 

6.4.2 项目和仿真状态的概述 

一般来说，项目视图会显示为下列的其中一种状态：  

● 项目未打开，仿真尚未运行 

● 项目未打开，仿真正在运行但尚未组态 

● 项目未打开，仿真已组态 

● 项目已打开，仿真尚未运行 

● 项目已打开，仿真正在运行但尚未组态 

● 项目已打开，仿真正在运行且已组态 
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6.4.3 项目未打开，仿真尚未运行 

下方截屏显示了“项目未打开，仿真尚未运行”状态下的项目视图： 

 

在该状态下，只有以下选项可用： 

● 新建项目 

– 请注意，创建项目时无需选择“仿真系列”(simulation family)。 

● 打开现有项目 

– 请注意，打开现有项目时有可能会（也可能不会）启动仿真。如果您之前保存的项

目中含有运行状态的仿真，则会重启该仿真。如果您之前保存的项目不含运行状态

的仿真，则项目视图打开时不启动任何仿真。 

● 选择用于仿真的 CPU 系列，然后启动仿真 

– 从主工具栏选择玩 CPU 系列后，单击电源按钮以启动仿真。 

● 切换到精简视图 
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6.4.4 项目未打开，仿真正在运行但尚未组态 

如果已选择通过单击电源按钮启动仿真，但尚未通过从 TIA Portal 
下载的方式来组态仿真，则项目视图的变化不大。电源按钮会变绿，以指示仿真正在运行

。RUN/STOP 按钮保持禁用状态，并且不会显示任何 IP 地址。  

但是，S7-PLCSIM 现将显示为一个目标，用于从 TIA Portal 
进行下载。随后可以下载并调试 TIA Portal 中的程序和硬件组态。 

 

在该状态下，以下选项可用： 

● 新建项目 

– 如果在仿真处于运行状态时新建项目，则会使新项目与已在运行的仿真相连。 

● 打开现有项目 

– 打开现有项目并不会终止正在运行的仿真。打开的项目可能会（也可能不会）包含

仿真。如果打开的项目不包含仿真，则在打开项目之前，现有仿真将关闭。 
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● 使用电源按钮终止仿真 

– 将电源按钮切换到关闭状态即可终止正在运行的仿真。 

● 切换到精简视图 

6.4.5 项目未打开，仿真已组态 

通过从 TIA Portal 下载的方式来组态仿真后，项目视图会显示启用的 RUN/STOP 按钮。  

 

在该状态下，以下选项可用： 

● 新建项目 

– 如果在仿真处于运行状态时新建项目，则会使新项目与已在运行的仿真相连。 

● 打开现有项目 

– 打开现有项目会终止正在运行的仿真。打开的项目可能会（也可能不会）包含仿真

。如果打开的项目不包含仿真，则在打开项目之前，现有仿真将关闭。 
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● 使用电源按钮终止仿真 

● 切换到精简视图 

6.4.6 项目已打开，仿真尚未运行 

如果选择新建项目但尚未启动仿真，则项目视图将如下所示： 

 

对于打开的项目，可以创建并编辑 SIM 
表和序列。项目树会显示没有仿真处于运行状态。项目视图显示了当前所选 CPU 
系列的未组态 CPU。 

可以通过选择要仿真的 CPU 
系列，然后单击电源按钮来启动该项目的仿真。执行这一操作时，项目会与正在运行的仿

真相连。  

无需启动仿真即可保存 S7-PLCSIM 
项目。重新打开项目时，项目视图将如上面的截屏所示。 
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6.4.7 项目已打开，仿真正在运行但尚未组态 

如果您已创建或打开了项目并启动了仿真，则项目视图显示如下： 

 

项目树会显示采用默认名称和类型的仿真。电源按钮会变绿，以指示当前 CPU 
系列的仿真正在运行。从 STEP 7 
进行下载之前，尚未组态仿真。切换至设备组态时，会显示当前所选系列的未组态 
CPU。  
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6.4.8 项目已打开，仿真正在运行且已组态 

在该状态下，存在一个打开的项目，仿真正在运行且已通过从 TIA Portal 
下载的方式完成组态。项目视图将以全功能状态显示。 

 

可以看到，项目视图已转到在线状态。仿真状态以及所组态的 CPU 
的名称和系列将显示在项目树中。 
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6.5 在线和离线状态的视觉反馈 
当 S7-PLCSIM 与已仿真的 PLC 
之间建立活动连接时，会在精简视图中指示在线状态。只有在以下情况下才会指示在线状

态： 

● 从 STEP 7 向 S7-PLCSIM 执行下载操作后 

● 打开之前组态的项目时 

如果尚未从 STEP 7 进行下载，则 S7-PLCSIM 
将处于离线状态。在精简视图和项目视图中，离线状态通过深蓝色的标题栏进行指示。 

当 S7-PLCSIM 在项目视图中处于在线状态时，应用程序的右下角会出现动画显示： 

 

6.6 使用设备组态视图 

6.6.1 设备组态视图的概述 

设备组态包含两部分： 

● 已组态的硬件 

● 地址 

已组态的硬件 

S7-PLCSIM 
提供有设备组态视图，可供用户查看为仿真下载的硬件组态。在该视图中，只能以“只读”
形式查看硬件。  

不能对设备组态中的硬件进行任何更改。如果要修改硬件组态，则必须在 STEP 7 
中进行该操作，然后将其下载到 S7-PLCSIM 中以仿真新的硬件组态。 

地址 

当在硬件部分选择一个设备时，“地址”(Addresses) 部分会显示该设备各个 IO 
通道的条目。  
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6.6.2 设备组态用户界面 

设备组态视图包含两部分：  

1. 设备组态部分，用于显示从 STEP 7 下载的硬件。 

2. “地址”（Addresses）部分，显示可能用于输入和输出设备的所有地址以及 SIM 
表的子集，使用该子集可以监视和修改值，而无需切换到完整的 SIM 表编辑器。 
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设备组态 

设备组态用于显示从 STEP 7 下载的硬件。设备组态仅用于显示。无法在 S7-PLCSIM 
中更改设备组态。  

正常工作的模块会显示一个绿色的复选标记。有故障的模块会显示一个故障图标。CPU 
会显示 RUN 或 STOP 图标，具体取决于其状态。这与 STEP 7 中的显示相同。  

控件 

组态的硬件部分中的工具栏与 STEP 7 设备组态中的控件类似： 

● 用于切换模块名称的按钮 

● 选择放大、缩放选项和缩小的按钮 

● 指示缩放百分比的下拉列表框 

地址 

设备组态还包含地址部分，其中包括 SIM 
表（“名称”(Name)、“地址”(Address)、“显示格式”(Display format) 
和“监视/修改值”(Monitor/Modify value)”列）的子集。  

 

6.6.3 设备组态部分 

6.6.3.1 已组态的硬件部分 

已组态的硬件部分概述 

每次从 STEP 7 
下载完成之后，设备组态视图的已组态硬件部分都将自动更新，以显示下载的硬件组态。

已组态硬件部分显示设备名称，显示方式与在 STEP 7 设备组态部分中的显示方式相同。  

支持的硬件 

S7-PLCSIM 支持无误下载任意支持的 S7-1200、S7-1500 或 ET 200SP 
设备组态。但是，无法对 S7-PLCSIM 
不识别的设备进行仿真。未识别的设备在设备组态视图将被忽略。  
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未识别的硬件 

STEP 7 安装可能支持设备组态无法识别的新硬件。前提是 STEP 7 已通过硬件支持包 
(HSP) 进行更新。  

通过 HSP（硬件支持包）安装的硬件 

如果已使用硬件支持包安装了设备，设备组态中可能不显示这些设备。  

已组态硬件部分中的撤消和恢复 

设备组态的已组态硬件部分不支持通过“撤消/重做”进行任何操作。设备组态的硬件部分为

“只读”部分。 

已下载的中央和分散硬件显示 

设备组态视图的已组态硬件部分会显示从 TIA Portal 下载到 S7-PLCSIM 
的硬件详细信息。  

已组态硬件部分用于显示中央和分散（远程）模块。但是，S7-PLCSIM 
不能显示故障安全 CPU 和故障安全分散 IO 的硬件组态。  

如果 S7-PLCSIM 不能显示设备的硬件组态，可在设备组态的地址部分或 SIM 
表中手动输入该设备的地址。  

设备组态视图的功能 

设备组态视图中不提供编辑选项。该视图用于提供硬件组态的状态和调试信息。如果需要

编辑硬件组态，则必须在 TIA Portal 中进行编辑。 

设备状态指示符 

S7-PLCSIM 显示了用于指示设备在线状态的图标。该信息与在线模式下 TIA Portal 
STEP 7 设备组态中显示的信息完全相同。 

显示 IO 地址的变量 

S7-PLCSIM 
会获悉用户在执行完下载后为程序定义的变量。设备组态会显示已识别设备的 IO 
通道的变量名称，其显示方式与 TIA Portal STEP 7 设备组态中的显示方式相同。 
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缩放因子 

设备组态工具栏中包含缩放控件，可供用户缩放查看硬件组态。这些控件的作用与 
TIA Portal STEP 7 设备组态中相同。 

6.6.3.2 地址部分 

地址部分概述 

设备组态包含一个拉出部分，可为硬件组态部分中所选设备的每个 IO 
通道显示相应的条目。该地址部分起到 SIM 表编辑器子集的作用，方便查看并设置 IO 
通道的值。 

可以为硬件组态部分中的一个或多个设备选择和使用 IO 通道： 

 

地址部分中的撤消和恢复 

设备配置视图的地址部分支持向/从所选设备的 IO 
通道读取/写入数据。不能撤消或恢复这些操作。 
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6.6.4 设备组态中的撤消和恢复 

S7-PLCSIM 
提供有设备组态，可供用户查看为仿真下载的硬件组态。在该视图中，只能以“只读”形式

查看已组态的硬件。无法在设备组态的已组态硬件部分编辑任何内容，因此撤消和恢复不

可用。  

6.6.5 从 STEP 7 进行下载之前的设备组态视图 

如果已创建或打开一个项目，但还未从 STEP 7 执行下载操作，设备组态视图会显示默认 
S7-1500 系列的通用 PLC。 

如果 PLC 断电，通用 PLC 标签显示“PLC 断电”(PLC Powered Off)；如果 PLC 
通电，显示“未组态的 PLC”(Unconfigured PLC)。 

6.6.6 从 STEP 7 进行下载之后的设备组态视图 

通过从 STEP 7 下载的方式来组态仿真后，或者打开的项目中包含已组态的 CPU 时： 

● 设备组态视图的硬件组态部分会显示已下载的 PLC 的名称和型号。 

● 地址部分会显示已下载的 PLC 的板载地址。 

6.7 SIM 表和序列编辑器的通用功能 

6.7.1 通用功能概述 

S7-PLCSIM 具有两个基于网格的编辑器视图：SIM 表和序列。  

这两个视图有很多相同的功能。以下部分介绍了 SIM 表和序列编辑器的通用功能。 
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6.7.2 通用的剪贴板操作 

S7-PLCSIM 编辑器支持针对以下内容的剪贴板操作（剪切/复制/粘贴）：  

● 单元格中的文本 

● 单元格内容 

● 单行（选中的整行） 

● 多行（各行可以是连续的，也可以时不连续的） 

可以通过以下方式选择剪贴板操作： 

● 使用标准 Windows 快捷键： 

– Ctrl+C 用于复制 

– Ctrl+X 用于剪切 

– Ctrl+V 用于粘贴 

● 每个编辑器中的快捷菜单；在编辑器中单击右键即可访问 

● 主工具栏上的“编辑”(Edit) 菜单 

通过上述方式发起的剪贴板操作与标准 Windows 操作相同。  

选择多个行进行剪贴板操作 

S7-PLCSIM 支持选择多个行进行剪贴板操作，操作方式通常与 Windows 操作相同。 

可以通过以下方式选择多个行： 

● 左键单击某一行的选择列，然后向下或向上拖动鼠标以选择多个连续的行。 

● 单击某一行的选择列，然后按住 Shift 
键并单击另一行（原始行上方或下方的行），以选择这两行之间的所有行。 

● 要选择多个不连续的行，请单击某一行的选择列，然后按住“Ctrl”键的同时选择其它行

。单击的所有行随后都将成为选择的行。 
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6.7.3 添加、编辑和删除行 

S7-PLCSIM 视图经设计始终有一个“空行”，可供用户向 SIM 
表或序列中添加新的条目。S7-PLCSIM 支持在编辑器的任意有效位置添加或插入空行。 

● 选择“添加行”(Add row) 时，将立即在当前编辑焦点所处的行下方添加一个新的空行。 

● 选择“插入行”(Insert row) 
时，则将立即在当前编辑焦点所处的行上方添加一个新的空行。 

● 如果已选择多个行且这些行均有焦点，则选择“添加行”(Add row) 
时将在第一个所选行的下方添加新行；选择“插入行”(Insert row) 
时将在第一个所选行的上方添加新行。请注意，这两个选项在序列编辑器中可能不会

始终可用，因为该编辑器中的第一行和最后一行存在特殊性。 

S7-PLCSIM 
视图还支持从编辑器中删除一个或多个行。通过上述方法选择行之后，可以使用标准键盘

或菜单命令删除行。 

6.7.4 地址变量的应用 

从 STEP 7 执行下载操作后，S7-PLCSIM 会检查已下载程序的变量信息。请注意，在 
SIM 表、序列或设备组态中更改的变量信息不会“上传”到STEP 7。  

每次从 STEP 7 执行下载操作时，S7-PLCSIM 都会根据以下规则更新 STEP 7 
中自上次下载操作后发生变化的变量信息： 

● 如果编辑器行仅包含一个地址但不包含名称，而更新的变量信息包含该地址对应的名

称，则该条目会自动更新以同时显示变量名称和地址。 

● 如果编辑器行包含一个未定义的变量（显示为错误），而更新的变量信息包含该变量

名称的定义，则该条目会自动更新以显示该变量的信息，同时错误条件将被清除。 

● 如果编辑器行包含一个变量名称及其相关地址，而更新的变量信息不包含该地址的变

量，则会保留该条目的地址信息。输入的变量名称将被删除。 

● 如果编辑器行包含一个变量名称及其相关地址，而更新的变量信息包含该地址的其它

变量名称，则会自动更新该变量名称。 
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6.7.5 自动补全变量 

S7-PLCSIM 
支持一种变量名称“自动补全”机制，可辅助用户输入变量名称。自动补全功能会检查用户

输入的文本，然后提供一个与该文本匹配的变量名称列表。  

以 STEP 7 中定义的如下变量表为例： 

 

将该项目下载到 S7-PLCSIM 时，S7-PLCSIM 
会从下载的变量信息中获悉变量。随后，用户可在 SIM 表或序列中使用更新的信息。 

输入变量名称时，自动补全功能会尝试将输入的文本与之前定义的变量匹配。例如，如果

在 SIM 表或序列中输入文本“In”，则会自动显示以下变量选项：  

 

可使用箭头键滚动列表，然后使用 Enter 
键进行选择。从列表中选择某个变量后，会自动为该条目设置相应的地址和默认显示格式

。 
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自动补全功能还可用于数据块和用户自定义数据类型。向 S7-PLCSIM 
执行下载操作时，将按照获悉变量和地址的方式获悉数据块结构和用户自定义数据类型。

这些条目在 SIM 表或序列中有效，并且自动补全功能适用于这些元素。 

6.7.6 通用行指示符 

6.7.6.1 通用行指示符概述 

SIM 表和序列编辑器有多个通用的行指示符图标： 

● 错误 

● 强制地址 

● 故障安全模块以及相关的变量 

6.7.6.2 错误指示符 

只要编辑器中存在无效数据，便会被标记为错误。 

包含无效数据的单元格呈粉色，包含无效数据的行将标记有“ ”错误图标。 

6.7.6.3 强制指示符 

“强制图标”  指示从 STEP 7 下载的强制地址。该图标与 STEP 7 
中使用的图标相同。该图标对于完全强制地址和部分强制地址均适用。该图标将显示在以

下位置：  

● 包含从 STEP 7 下载的完全强制地址或部分强制地址的 SIM 表行。 

● 包含从 STEP 7 
下载的完全强制地址或部分强制地址的序列步。不过，如果禁用序列步，则不会显示

强制图标。 

● 包含从 STEP 7 下载的完全强制地址或部分强制地址的设备组态地址。 
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6.7.6.4 故障安全指示符 

在 S7-PLCSIM 中，故障安全 I/O 地址以故障安全颜色黄色进行显示（与 TIA Portal 
中相同）。 

只要下列部分使用故障安全地址，便会以黄色显示： 

● SIM 表编辑器 

● 序列编辑器 

● 设备组态视图的地址部分 

6.8 在 SIM 表编辑器中工作 

6.8.1 SIM 表编辑器说明 

SIM 表的设计与 STEP 7 监视表类似：  

 

S7-PLCSIM 会自动将名称“SIM table_[n]”分配给新的 SIM 表，其中 [n] 
表示下一个未使用的可用编号。  

新项目中已包含一个名为“SIM table_1”的 SIM 表。因此，如果新增一个 SIM 
表，则默认情况下，为其分配名称“SIM table_2”。  

可以通过右键单击 SIM 表名称并选择“重命名”(Rename) 来重命名 SIM 表。  

一个仿真项目可包含一个或多个 SIM 表。每个 SIM 表的名称都必须唯一。  
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SIM 表工具栏 

使用 SIM 表编辑器工具栏上的图标可以执行以下操作：  
 

图标 功能 说明 

 插入行 紧贴当前光标位置上方插入一个新的空行。 

 添加行 紧贴当前光标位置下方插入一个新的空行。 

 修改所有选定的值 对于已选中此复选框从而以“统一”或“批量”模式写入值的行，

在“统一修改”(Consistent modify) 列中写入值。  

 启用/禁用非输入的修改 默认情况下，只能将更新写入到输入中。单击此按钮后，将

能够向输出、存储区和数据块地址写入更新。  

此按钮仅用于指示编辑选项，此操作并非在线操作。 

 导出到 Excel 以 Microsoft Excel .xlsx 文件格式导出 SIM 表的内容。 

 从 Excel 导入 将 Microsoft Excel .xlsx 文件的内容导入到 SIM 表。 

 加载项目变量 将当前已从 STEP 7 项目下载的所有变量加载到打开的 SIM 
表中。当前不存在已下载的变量时此按钮禁用。 

 保存窗口设置 保存对 SIM 
表编辑器的外观所做的所有更改，例如列宽。保存的设置也

将应用于新创建的 SIM 表。  
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SIM 表编辑器各列 

下表介绍了 SIM 表编辑器的各个列：  
 

列 说明 

指示符  

（无列标题）  

此列显示有关 SIM 表条目的信息。  

 输入有效变量名称或从下载的 STEP 7 
程序中输入用于有效变量名称的地址时，该列会显示紫色变量图标

。 

如果存在故障安全变量，则会在黄色背景上显示紫色变量（与在 
TIA Portal 中一样）。 

 如果条目发生错误，则将显示红色“X”。将显示一条错误消息。 

 只要地址被强制就会显示强制指示符。例如，部分强制的地址在 
SIM 表中与完全强制的地址显示相同的强制图标。  

名称  显示变量名。  

地址  显示变量地址。 

显示格式  可以使用不同的显示格式，具体取决于条目类型。某些示例中包含布尔、十六进

制和有符号十进制 (DEC +/-) 数据。  

监视/修改值  显示条目的当前值。  

位  如果地址是一个位或字节地址，则一系列的复选框（每位一个框）将显示在字段

中。从左到右，位顺序依次为：7，6，5，4，3，2，1，0。 

一致修改  单击“修改所有选定值”(Modify all selected values) 按钮之后，该值将被写入 
PLC。  

 
如果希望在单击工具栏中的“修改所有选择的值”(Modify all selected values) 
按钮之后修改行中的值，请选中本列中的复选框。  

注释  可以在此添加注释，为 SIM 表格条目提供说明。 
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SIM 表编辑器快捷菜单 

如果在 SIM 表中单击右键，将显示以下快捷菜单：  

 

6.8.2 在 SIM 表编辑器中工作概述 

通过 S7-PLCSIM SIM 表，可以修改仿真输入并读取仿真输出。它类似于 STEP 7 
的监视表，主要用于修改外设输入并读取外设输出。  

一个仿真项目可包含一个或多个 SIM 表。可以针对相同的已仿真 PLC 同时运行多个 SIM 
表。 

变量名称和地址显示 

只要从 STEP 7 下载程序，任何打开的 SIM 表都会自动开始监视指定的变量和地址。 

强制地址 

强制值优先于 S7-PLCSIM 操作。请注意，强制值可能会改变您的仿真行为。  
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6.8.3 SIM 表编辑器中的撤消和恢复 

SIM 
表编辑器支持针对您执行的许多操作进行撤消和恢复。不过，有些操作无法撤消和恢复。  

不支持撤消和恢复的操作示例包括： 

● 编辑“监视/修改值”(Monitor/modify value) 的文本 

● 选中“位”(bits) 复选框 

● 修改所有选定的值（工具栏按钮） 

● 从 Excel 导入（工具栏按钮） 

● 导出到 Excel（工具栏按钮） 

● 启用/禁用非输入的修改（工具栏按钮） 

请注意，附加操作（例如，从 STEP 7 下载程序）可能擦除撤消/恢复序列的内容。 

6.8.4 创建和填充 SIM 表 

6.8.4.1 创建和填充 SIM 表概述 

可通过以下方式在 SIM 表中添加或插入行，或者创建整个 SIM 表：  

● 使用自动填充功能基于所选变量或地址创建更多行 

● 复制并粘贴全部或部分 STEP 7 变量表、监视表或强制表 

● 拖放 S7-PLCSIM 设备组态视图的硬件组态部分中的模块 

● 使用 Microsoft Excel 导入全部或部分 STEP 7 变量表、监视表或强制表 

6.8.4.2 SIM 表：从 STEP 7 加载项目变量 

可使用 SIM 表编辑器工具栏上的“加载项目变量”(load project tags) 按钮  将 STEP 7 
变量加载到打开的 SIM 表中。  

单击此按钮会加载最近一次从 STEP 7 下载的所有变量。 

如果最近一次下载操作中无变量，则“加载项目变量”(load project tags) 按钮会被禁用。 

6.8.4.3 在 SIM 表中使用自动填充 

可以使用自动填充功能填充 SIM 表。SIM 表的自动填充方式与 STEP 7 
监视表中的填充方式相同。  
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必须至少已输入一行，以便使用自动填充功能基于该变量递增地址。 

下载后，也可以自动填充“名称”(Name) 字段。 

自动填充步骤 

使用以下步骤自动填充 SIM 表中的行： 

1. 在 SIM 表的“地址”(Address) 
字段中输入地址。在该字段的右下角将显示一个蓝色的小方块。 

 

2. 将鼠标指针悬停在蓝塞方块上。将出现一个加号（“填充句柄”）。单击并按住鼠标键，

同时向下拖动以填充要添加的地址。 

 

3. 将根据所选变量，按先后顺序添加变量。例如，以所选地址“I0.0”开始自动填充三行，

将添加 I0.1、I0.2 和 I0.3。 

 

4. 如果在要进行自动填充的所选单元格中已存在条目，则将显示“自动填充”(AutoFill) 
对话框。选择“覆盖现有元素”(Overwrite existing elements) 或“插入元素”(Insert 
elements)。 

6.8.4.4 SIM 表： 复制和粘贴 STEP 7 中的变量和表 

可以将 STEP 7 
变量表、监视表或强制表中的一个变量、多个变量或所有变量复制并粘贴到 S7-PLCSIM 
SIM 表。 

下载前，可以从 STEP 7 复制和粘贴变量地址。下载后，可以从 STEP 7 
复制和粘贴变量地址或变量名称。 
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复制和粘贴结构化变量 

S7-PLCSIM 
以不同方式粘贴结构化变量。复制结构化变量时，单元格变红。单击相应单元格，在变量

名称未尾添加一个句点，下拉列表将显示变量的所有子节点。然后可以选择子节点变量在 
S7-PLCSIM 中粘贴和使用。  

复制结构化变量时，单元格变红。单击相应单元格，在变量名称未尾添加一个句点，下拉

列表将显示变量的所有子节点。然后可以选择子节点变量在 S7-PLCSIM 中粘贴和使用。 

复制和粘贴步骤 

采用以下步骤，将 STEP 7 中的变量复制并粘贴到 S7-PLCSIM： 

结果：STEP 7 变量添加到 SIM 表中。 

1. 在 STEP 7 
变量表、监视表或强制表中选择一个或多个变量名称、变量地址或这两者。可以使用 
Shift 键选择连续的多个变量，也可以使用 Ctrl 键选择不连续的多个变量。 

2. 使用 Ctrl+C，或单击右键并从快捷菜单中选择“复制”(Copy)。 

3. 在 SIM 表中选择一个变量名称字段、变量地址字段或两者。 

4. 使用 Ctrl+V，或单击右键并从快捷菜单中选择“粘贴”(Paste)。 

结果：STEP 7 变量添加到 SIM 表中。 

 
 

 
说明 

“剪切和粘贴”与“复制和粘贴” 
在两个打开的 S7-PLCSIM 
实例之间执行剪切和粘贴操作时，源实例中的数据会被复制而不是被剪切。 
要解决此问题，可删除源实例中已剪切或复制的行。 
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6.8.4.5 SIM 表： 通过 Microsoft Excel 导入和导出 

S7-PLCSIM 导出按钮  可导出 .xlsx 格式的现有 SIM 
表，此表可导入到同一项目中的另一个 SIM 表，或导入到不同项目中的 SIM 表。  

导入按钮  可通过导入包含如下内容的 .xlsx 文件来创建或扩展 SIM 表：  

● 其它 SIM 表的内容 

● STEP 7 变量表、监视表或强制表的内容 

导出和导入步骤 

将 STEP 7 中的表导出到 Microsoft Excel 文件： 

1. 在 STEP 7 
变量表、监视表或强制表中选择变量。请注意，无论选择多少变量，都将导出整个表

。 

2. 右键单击并从右键快捷菜单中选择“导出”(Export)。 

3. 为导出的 Excel 文件选择一个位置和名称。 

4. 单击“打开”(Open)。 

结果：以您输入的名称和位置导出整个表。 
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将 Microsoft Excel 文件中的表导入到 SIM 表： 

1. 打开 SIM 表。 

2. 从 SIM 表工具栏中选择“导入”(Import) 按钮，或从 SIM 表快捷菜单中选择“从 Excel 
导入”(Import from Excel)。 

3. 找到要导入的 Excel 文件。请注意，必须关闭导入文件才能正常执行导入操作。 

4. 单击“打开”(Open)。 

结果：.xlsx 文件的内容出现在 SIM 表中。 
 

 
说明 

导入包含空地址字段的文件 
如果 .xlsx 
文件包含一个或多个空地址字段，则会显示一条警告消息，指示仅成功执行部分导入操作

。在包含空地址字段的行的状态指示符列中会显示一个错误图标。  
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6.8.4.6 拖放设备组态中的模块以创建 SIM 表 

S7-PLCSIM 支持通过将设备组态视图中的设备拖放到 SIM 表中的方式来填充 SIM 
表。可以通过单击“水平拆分窗口”(split window horizontally) 
按钮或悬浮编辑器窗口，以使设备组态视图和 SIM 
表编辑器同时显示在项目视图中，这样拖放起来就变得非常简单。 

 

其中同时显示了设备组态视图和 SIM 表。通过设备组态视图中的“地址”(Addresses) 
选项卡，可以查看为该设备定义的某些变量。 

通过在图形视图中选择设备并将其拖放到 SIM 表中，可以为设备上的所有 IO 通道添加 
SIM 表条目。 

如果选择将模块拖放到已包含条目的 SIM 上，则该模块的新条目将被附加到 SIM 
表末尾。 

完成拖放操作后，设备和 SIM 
表之间将不再关联。当针对设备组态的更改（例如，针对模块地址的更改）下载到 
S7-PLCSIM 中时，将不会自动反映在 SIM 表中。  

您也可以通过按住 Ctrl 
键并单击想要选择的模块，以此在设备组态视图中选择多个设备。将这些设备拖放到 SIM 
表中，即可使用全部所选设备的 IO 地址填充该表。 
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6.8.5 监视和修改 SIM 表值 

“监视/修改值”(Monitor/Modify Value) 列以“显示格式”(Display format) 
列中选择的格式显示当前值。可以单个（使用此列）或“统一”（批量）模式（使用“统一修

改”(Consistent modify) 列）修改 SIM 表中的值。  

请注意，某些 SIM 表值只能在虚拟 PLC 处于运行模式时更新。 

位和字节值显示 

如果地址为位地址，则会在“位”(Bits) 列显示一个复选框。  

如果地址为字节地址，则会在“位”(Bits) 
列显示八个复选框（一位对应一个复选框）。位的顺序从左到右为：7，6，5，4，3，2
，1，0。 

下图显示了 SIM 表四行的复选框，其中两个表示位地址，两个表示字节地址： 

 

展开字节地址 

输入字节地址时，条目名称旁会出现一个三角图标 。三角图标表示可以展开条目。 

单击三角图标之后，字节地址将展开，显示字节中每个位单独的条目。这些“已展开”条目

的名称和地址是只读的。 
 

 
说明 
即使输入新值，SIM 表也会继续监视及更新。 

 

修改非输入地址 

默认情况下，只能将值写入到输入中。借助 SIM 表编辑器工具栏按钮  
可向输出、存储器、定时器、计数器和数据块地址写入值。 

修改单个值 

在“监视/修改值”(Monitor/modify value) 和“位”(Bits) 
字段中输入一个值，该值将立即写入仿真 PLC 中。  
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要立即开始单独修改各个值，仅需在“监视/修改值”(Monitor/modify value) 
字段中输入新值即可。  

可使用“位”(Bits) 
字段中的各个复选框立即更改字节地址中各个位的值。每个位都有一个复选框。空复选框

表示值为 0 或 FALSE。选中的复选框表示值为 1 或 TRUE。  

在统一（批量）模式下修改值 

通过在“统一修改”(Consistent Modify) 字段中输入新值，可以同时更新多个值。  

在以“闪电”图标开头的列中，选中希望修改的字段所对应的复选框：  

 

黄色三角形指示，单击工具栏上的“修改所有选定值”(Modify all selected values) 按钮  
时，会应用一个值。此按钮会为所有包含修改值的已检查条目写入数据。如果没有与仿真 
PLC 建立活动连接而单击此按钮，则会显示一条警告消息。 
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6.8.6 通过记录的 SIM 表编辑器操作创建新的序列 

可以记录在 SIM 
表编辑器中进行的操作以创建序列，然后通过运行新序列回放这些操作。  

通过 SIM 表编辑器创建新序列的步骤 

执行以下步骤，以通过 SIM 表编辑器创建新序列： 

1. 创建 SIM 表。 

2. 执行从 STEP 7 下载。 

3. 单击主工具栏上的“开始记录”(Start recording) 按钮，或从“工具”(Tools) 
菜单中选择“开始记录”(Start recording)。 

4. 在 SIM 
表部分输入操作，如添加或删除条目以及以单个或“统一”（批量）模式更改值。 

5. 如果在记录操作期间想要暂停，则单击主工具栏上的“暂停记录”(Pause recording) 
按钮，或从“工具”(Tools) 菜单中选择“暂停记录”(Pause recording)。 

6. 要恢复记录，请再次单击或选择“暂停记录”(Pause 
recording)。完成记录操作后，单击主工具栏上的“停止记录”(Stop recording) 
按钮，或从“工具”(Tools) 菜单中选择“停止记录”(Stop recording)。 

结果：通过记录的操作创建了一个新序列，该序列以默认名称显示在“序列”(Sequences) 
文件夹中。如果需要，可重新命名该序列。 

6.8.7 SIM 表错误条件 

SIM 
表编辑器可以识别多种错误条件。条目出错时，出错的单元格将显示为粉色，红色“X”图
标  将出现在指示符列中，并且 S7-PLCSIM 
不会采集该条目的数据。但是，将继续监视所有有效条目。  

在输入时便已确认以下错误条件： 

● 地址无效（例如，语法错误） 

● 地址超出范围；也就是说，地址对于硬件的物理存储器过大 

● 监视/修改值超出数据类型范围 
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导入文件中的空地址字段 

如果 Microsoft Excel .xlsx 
文件包含一个或多个空地址字段，则会显示一条警告消息，指示仅成功执行部分导入操作

。在包含空地址字段的行的状态指示符列中会显示一个错误图标。  

6.9 在序列编辑器中工作 

6.9.1 在序列编辑器中工作概述 

序列的主要作用是仿真与用户程序交互的外部过程。外部过程通过输入与 PLC 
交互。输入一个输入地址 (%I) 时，该地址自动转换为外围设备输入地址 
(%I:P)，从而可以更精确地仿真物理线路的信号。  

序列编辑器和地址 

可以操作序列中的以下任意地址区：  

● 外围设备输入 (%I:P) 

● 输出 (%Q) 

● 存储器 (%M) 

● 数据块 (%DB) 

● 定时器 (%T) 

● 计数器 (%C) 

通过序列编辑器，可在输入、输出和存储器地址中定义一组定时值更改。序列可用来仿真

外部设备对运行程序的行为。这样可以观察程序逻辑的结果，以便进行任何可能必要的调

整。  

项目可包含多个序列，但是同一时间只能运行一个序列。最好创建多个序列以查看对程序

逻辑进行各种调整后的效果，而不是多次修改同一个序列。  

保存项目时，也会保存序列。可将其重复进行多次来帮助调试程序。  

当某个序列不再有用时，将其从项目中删除即可。 

关于强制地址的注意事项 

强制值优先于 S7-PLCSIM 操作。请注意，强制值可能会改变您的仿真行为。  
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6.9.2 序列编辑器说明 

 

S7-PLCSIM 会自动将名称“Sequence_[n]”分配给新的序列，其中 [n] 
是下一个未使用的可用编号。例如，项目的第一个序列分配到的名称为“Sequence_1”。  

可以通过右键单击序列名称并选择“重命名”(Rename) 来更改名称。  

一个仿真项目可包含一个或多个序列。每个序列的名称都不得重复。 

序列编辑器工具栏 

序列编辑器工具栏包括下列功能：  
 

按钮 功能 

 

插入步  

紧贴当前所选步上方插入一个新的空步

。 

 

添加步骤  

紧贴当前所选步下方插入一个新的空步

。 

 

启用步  

启用之前禁用的步。 

 

禁用步  

禁用一个步，以便运行序列时跳过该步

。 

 

步时间调整  

调整单个步的时间 

 

启动序列  

从头开始播放序列。 

此按钮仅在以下条件为真时可用： 

• 不存在任何其它当前正在运行的序列

。 

• 序列中没有任何错误。 

也可单击该按钮来恢复暂停的序列。 
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按钮 功能 

 

停止序列  

立即停止运行序列。 

 

暂停序列  

在当前执行的步骤处暂停序列。  

必须单击“启动序列”(Start sequence) 
按钮来恢复暂停的序列。 

 

重复序列  

循环执行序列，直到手动停止序列。  

 

默认时间间隔和时间格式设置  

用于输入以毫秒为单位的时间，以增加

最新添加行的“时间”(Time) 
列中的时间。有效范围是 0 到 3600000 
ms。使用时间格式设置更改时间格式。 

 

导出到 Excel  

导出序列为 Excel 格式。 

 

从 Excel 导入  

从跟踪测量导入  

允许选择导入 Excel 
电子数据表或跟踪测量文件。 

 

执行时间 

显示运行序列的总执行时间，以及重复

序列的重复次数。  

 

保存窗口设置 

保存对序列编辑器外观的任何更改，例

如列宽和拆分窗口。保存的设置也将应

用于您所创建的新序列。  
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序列编辑器列 
 

列 说明 

指示符（没有列标

题）  
此列将显示图标来指示以下信息： 

 序列中的第一步 

 序列中的最后一步 

 在播放过程中正在执行的步骤 

 序列中的错误 

时间  以时:分:秒.小数秒 (00:00:00.00) 
的形式显示时间。允许的最大时间为 23:59:59.95。 

名称  显示变量名。  

地址  显示步骤所影响的存储器地址。 

显示格式  

 

可以使用不同的显示格式，具体取决于变量的数据类型。例如，一

些可用的显示格式包括：布尔型、十六进制和浮点数。 

操作  对于序列中的第一步，唯一的选项是“启动序列”(Start sequence)。 

对于序列中的最后一步，可以： 

• 停止序列 

• 重复序列 

对于操作步，可选择： 

• 设置为值 (Set to value) 

• 设置为频率 (Set to frequency)（仅用于输入位存储器） 

操作参数  操作参数基于操作列： 

• 对于“设置为值”(Set to 
value)，可以输入与条目数据类型兼容的数值。 

• 对于“设置为频率”(Set to frequency)，可以输入频率 (Hz)。 

注释  可以在此添加注释，为步骤提供说明。 
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序列编辑器各行（步） 

序列编辑器中的每一行都表示序列中的一个步骤。指示符列中的图标指示第一步和最后一

步、在播放期间执行的步，以及某步是否存在错误：  
 

步骤和相关图标 说明 

 

启动步 

此为固定行，不接受条目。其包含的时间为“00:00:00.00”。 

“操作”(Action) 列中有两个选项： 

“立即启动”(Start immediately)  

“触发条件”(Trigger condition)  

可编辑的步 其时间介于序列中的第一步与最后一步之间的步骤。  

 

停止步 

序列中的最后一步。“操作”(Action) 列包含文本“停止序列”(Stop 
sequence) 或“重复序列”(Repeat sequence)。  

 

 

当前正在执行的步

骤 

指示当前正在执行的步骤。如果针对多个条目设置了相同的执行

时间，则其中只有一个条目会显示绿色箭头。 

 

错误指示符 

指示该步存在错误。消息中会显示错误的相关信息。  

 

序列编辑器快捷菜单 

右键单击步中的任意位置以显示下列快捷菜单：  
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这些快捷菜单命令与工具栏命令作用相同。 

6.9.3 序列编辑器中的撤消和恢复 

序列编辑器支持针对您执行的许多操作进行撤消和恢复。不过，有些操作无法撤消和恢复

。  

不支持撤消和恢复的操作示例包括： 

● 从 Excel 中导入（工具栏按钮） 

● 导出至 Excel（工具栏按钮） 

● 播放序列（通过工具栏按钮或快捷菜单） 

● 停止序列（通过工具栏按钮或快捷菜单） 

● 暂停序列（通过工具栏按钮或快捷菜单） 

● 对列排序 

● 选中或取消选中“重复序列”(Repeat sequence)（通过工具栏按钮） 

● 编辑执行时间 

请注意，附加操作可能还会擦除撤消/恢复队列的内容。 

序列播放期间的撤消和恢复 

播放或暂停序列时，撤消和恢复被禁用。即使当播放序列没有编辑焦点或者播放序列不可

见时，也会出现这一情况。  

当播放序列结束或用户明确停止播放序列时，撤消和恢复会再次启用。在序列播放期间执

行的任何编辑操作都将显示在撤消队列中。 

6.9.4 创建和填充序列 

6.9.4.1 创建和填充序列概述 

除了手动创建序列，然后输入和编辑步外，还有几种更为“自动”的方法用于在序列编辑器

中执行任务：  

● 使用自动填充功能基于所选地址或变量名称创建更多步 

● 通过记录的 SIM 表编辑器操作创建新序列 
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● 复制并粘贴全部或部分 STEP 7 变量表、监视表或强制表 

● 使用 Microsoft Excel 导入全部或部分 STEP 7 变量表、监视表或强制表 

● 从 STEP 7 中导入跟踪测量文件以创建序列 

参见 

序列：使用自动填充 (页 125) 

序列： 通过 Microsoft Excel 导入和导出 (页 127) 

通过记录的 SIM 表编辑器操作创建新的序列 (页 118) 

6.9.4.2 使用通过 SIM 表记录创建的序列 

打开通过 SIM 表编辑器中记录的操作创建的序列时，将看到序列步骤的时间与在 SIM 
表编辑器中输入的操作时间相匹配。  

可以按原样使用序列，也可以在各个步骤的“时间”(Time) 列中调整时间。  

要播放记录的序列，只需单击“启动序列”(Start sequence) 按钮即可。 

6.9.4.3 序列：使用自动填充 

自动填充功能在序列中的工作方式不同于其在 SIM 
表中的工作方式。在序列中，使用自动填充功能复制自动填充的单元格中的内容比递增此

单元格中的内容更为有用。随后可将不同的起始时间应用于同一个地址以查看对程序的影

响。  

下载之前，可以将“地址”(Address) 
字段用作自动填充的起始字段。完成下载后，可将“名称”(Name) 或“地址”(Address) 
字段用于自动填充的起始字段。 

自动填充行为和序列的最后一步 

如果已为序列的最后一步定义了时间，并且自动填充功能会导致超出此时间（由于存在默

认时间间隔），则 S7-PLCSIM 会在您执行自动填充时自动调整最后一步的时间。  
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自动填充与默认时间间隔 

在启动自动填充功能之前，将读取“默认时间间隔”(Default interval) 
中的时间。默认时间间隔值为 50 ms，不能使默认值小于 
50 ms。自动填充过程将使用此时间递增自动填充的步骤中的时间。各个自动填充步的时

间将与被选作自动填充基础的字段的时间相同。  

参见 

在 SIM 表中使用自动填充 (页 110) 

6.9.4.4 序列：复制和粘贴 STEP 7 中的变量和表 

可以复制 STEP 7 中的变量，然后将其粘贴到 S7-PLCSIM 序列，但与序列和 SIM 
表中复制和粘贴的工作方式有些差异。  

复制和粘贴与默认时间间隔 

无论默认时间间隔是多少，粘贴的每个步的时间均为 50 ms。  

可以使用自动填充功能将粘贴的步时间更改为数字。为最先粘贴的步手动输入期望的起始

时间，然后使用填充句柄根据需要调整任意数量的步时间。之后，各步的时间将按照默认

间隔时间递增。 

复制和粘贴结构化变量  

S7-PLCSIM 以不同于其它变量的方式粘贴结构化变量。粘贴结构化变量时，S7-PLCSIM 
中的单元格变红。单击相应单元格，在变量名称未尾添加一个句点，下拉列表将显示变量

的所有子节点。然后可以选择子节点变量在 S7-PLCSIM 中粘贴和使用。  
 

 
说明 

“剪切和粘贴”与“复制和粘贴” 
在两个打开的 S7-PLCSIM 
实例之间执行剪切和粘贴操作时，源实例中的数据会被复制而不是被剪切。 
要解决此问题，可删除源实例中已剪切或复制的行。 
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6.9.4.5 序列： 通过 Microsoft Excel 导入和导出 

可使用 Microsoft Excel .xlsx 文件通过导出和导入按钮  
对序列执行导出和导入操作，具体步骤与对 SIM 表执行的导出和导入步骤相同，但 SIM 
表与序列的导入和导出方式有所不同。 

编辑导出文件 

如果直接在 Microsoft Excel 
中编辑值（包括所导出序列文件中的值），然后将文件重新导入到 S7-PLCSIM 
中，则结果可能会偏离预期。  

可以通过以下两种方式之一解决该问题： 

● 要避免出现此问题，可以通过将时间的格式和其它数值字段更改为文本字段，然后再

编辑导出的 Excel 文件的方式来编辑 Excel 文件。 

● 可以让导入操作继续进行，然后在序列编辑器中手动编辑不正确的值。 
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导入和导出序列时的特别注意事项 

可以将 .xlsx 文件导入到空序列或导入到已包含步的序列。请确保导入的文件当前未在 
Excel 中打开，否则导入操作将失败。  

所导入序列步的时间将与步的时间字段中的时间相同。  

导入操作无法覆盖序列中的第一步或最后一步，因为这些步被保留。 

可以导出序列以填充当前项目或另一项目中的其它序列。 

如果 .xlsx 文件包含一个或多个地址字段为空的行，则这些行会作为空步导入序列中。 

导入到现有序列中的特殊情况 

如果序列已包含条目，将在现有条目底部和最后一步之前添加导入的行。  

如果已为序列中的最后一步定义了时间，并且导入过程导致超出该时间，则 S7-PLCSIM 
会自动调整停止时间以包含导入的步。 

导入包含结构化变量的监视表条目 

S7-PLCSIM 
以不同方式处理结构化变量。导入包含结构化变量的监视表的内容时，包含结构化变量的

单元格在 S7-PLCSIM 
中变红。单击相应单元格，在变量名称未尾添加一个句点，下拉列表将显示变量的所有子

节点。然后可以选择子节点变量以在序列中使用。  

参见 

SIM 表： 通过 Microsoft Excel 导入和导出 (页 113) 
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6.9.4.6 序列：从 STEP 7 跟踪进行导入 

通过跟踪创建序列概述 

S7-PLCSIM 允许您基于 STEP 7 跟踪测量文件创建序列。  

可以采用以下两种文件格式之一从 STEP 7 中导出跟踪： 

● 变量跟踪记录文件格式（.ttrec 或 .ttrecx） 

● Excel 逗号分隔值文件格式 (.csv) 

然后再将导出的文件导入到 S7-PLCSIM 中以创建序列。  

从 STEP 7 导出跟踪 

要导入的文件是从 TIA Portal 中以下列两种格式之一导出的跟踪文件： 

● TIA Portal 跟踪可导出为变量跟踪记录（*.ttrec 或 
*.ttrecx）。该文件不仅包含跟踪测量的变量信息和记录数据，还包含跟踪本身的组态

。请注意，S7-PLCSIM 将忽略组态信息。  

● TIA Portal 跟踪测量还可以采用 .csv（逗号分隔值）文件格式导出到 Microsoft Excel 
中。该文件只包含记录测量数据和变量信息。  

 

 
说明 
两种文件类型均包含跟踪测量的变量信息。S7-PLCSIM 
只使用地址信息，不使用变量信息。更新变量信息的唯一方式是从 STEP 7 
执行下载操作。 

 

导入 STEP 7 跟踪以创建序列 

可采用两种导入类型来通过 STEP 7 跟踪文件创建序列：  

● 从 Excel 文件（*.xlsx 或 *.xls 文件格式）导入 

● 从跟踪测量（*.ttrecx、*.ttrec 或 *.csv 文件格式）导入。 

因此，请确保选中“从跟踪测量导入序列”(Import sequence from trace measurement)。  

S7-PLCSIM 使用标准 Windows 文件对话框，方便您选择要导入的文件。 
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导入跟踪文件 

可导入 STEP 7 跟踪，以通过用户界面中的三个不同位置创建序列： 

● 在项目树中，右键单击“序列”(Sequences) 文件夹： 

 

● 序列工具栏“导入”(Import) 按钮的下拉菜单： 

 

● 在序列网格中，单击右键以显示快捷菜单： 
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跟踪测量地址 

可以定义 TIA Portal 
跟踪以记录多个地址的测量。您可能不希望序列中包括所有跟踪地址。例如，跟踪测量可

能包含输出地址的记录（%Q 存储器）。但这些地址对于 S7-PLCSIM 序列是无效的。 

当已选择要导入的文件后，S7-PLCSIM 
将检查跟踪测量并创建一个记录地址的列表。之后，您可以选择要使用哪个地址生成序列

。具体如下方的截屏所示：  

“导入跟踪测量”(Import trace measurement) 对话框具有以下特性： 

● 对话框中列出了跟踪测量的所有地址。如果对话框中显示的地址过多，会添加滚动条

。 

● 对于含可用变量信息的地址，将显示其变量名。变量名从下载到 S7-PLCSIM 
中的当前组态中获取 - 
而非来自导入的跟踪测量。对于不含可用变量名的地址，将默认显示“----”。 

● 默认情况下，除了输出地址以外的所有地址都将被选定进行导入。列表中的输出地址

为启用状态，但默认情况下不被选定进行导入。 

选择要包含的地址并单击“确认”(OK) 后，将通过跟踪测量生成一个序列。  
 

 
说明 
跟踪测量文件包含变量信息，但 S7-PLCSIM 仅使用地址信息，不使用变量信息。  
在 S7-PLCSIM 中更新变量信息的唯一方式是从 STEP 7 执行下载操作。 

 

关于序列生成的详细信息 

根据以下规则生成序列： 

● 为包含的每个地址生成一个“初始化步”。该步在跟踪文件中进行首次采样时生成，并

会将地址设为跟踪文件中首个采样的地址值。包含的每个地址都对应一个初始化步。

为了使这类步更加直观便于用户识别，将为每个步生成一个注释，内容如下：“初始步”
(Initial step)。请注意，如果不想使用初始化，则可编辑、禁用或删除步。 

● 每次包含的地址中有一个地址的值发生变化时，都将生成一个序列步。 
 

 
说明 
每次采样都会获取跟踪测量。如果地址值自上一次采样后未发生变化，则不会生成序列步

。 
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● 跟踪的采样时间会比各个序列步之间的最短递增时间短很多。对于跟踪文件中的每次

采样，S7-PLCSIM 
都会添加一个序列步。如果跟踪文件中相邻两次采样之间的时间差短于最短序列步递

增时间，则序列步会显示错误。必须先更正所有序列步时间错误，然后才能使用序列

。 

● 跟踪支持根据变量值触发记录。当选择该选项时，跟踪还支持记录触发前的值。这意

味着，在此预触发期间的跟踪测量的时间值为负。S7-PLCSIM 
序列不允许步的时间值为负。因此，当测量出现时间为负值的情况时，将对时间值进

行调整，从而使序列中的第一个测量时间值为零。后续步时间会被转换为正值。 

序列生成后，会成为 S7-PLCSIM 序列，即可以正常编辑和使用。与原始 TIA Portal 
跟踪之间不再存在连接。 

6.9.4.7 通过记录的 SIM 表操作创建序列 

概述 

可通过记录在 SIM 表中进行的操作创建一个序列。您可以使用此记录，基于 SIM 
表中记录的操作时间生成一个序列。  

可记录的 SIM 表操作 

以下示例详细介绍了可记录的 SIM 表操作，以及停止记录时将如何显示生成的序列。  

由于记录 SIM 
表操作的目的是创建序列，因此在生成的序列中，将针对在一段时间内为每个唯一的地址

更改值的每个操作记录一个步。例如，对于“监视/修改值”(Monitor/Modify value) 
列中的值进行的任意更改，都将相对于值发生变化的时间被记录为所生成序列中的一个新

步。 

如果在一段时间内对某个值进行多次更改，则每次更改都将在生成的序列中成为一个步。 

单击位复选框以更改“位”(Bits) 列中的值，或者使用“统一修改”(Consistent modify) 
列来更改单个值或多个值，可以获得相同的结果。 

您还可以在设备组态的“地址”(Addresses) 
部分进行可记录的操作。可以在该部分立即修改属于选定硬件模块的地址。激活记录时，

将对在设备组态的“地址”(Addresses) 部分进行的任何操作进行记录，记录方式与在 SIM 
表中执行对应操作时的记录方式相同。 
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为了符合最小序列步时间分辨率规范要求，S7-PLCSIM 
将序列操作的时间舍入为最接近的且为 10 ms 的整数倍的值。 

如果两个操作的时间间隔不足 50 ms，则生成的序列中将出现错误。 

记录 SIM 表操作 

SIM 表工具栏包含三个用于记录和播放的按钮： 
 

 “记录”(Record) 按钮 

 “停止记录”(Stop recording) 按钮 

 “暂停记录”(Pause recording) 按钮 

单击“记录”(Record) 按钮时，S7-PLCSIM 开始记录在 SIM 
表中进行的操作，以便通过这些操作生成一个序列。  

单击“暂停”(Pause) 按钮时，S7-PLCSIM 
会暂停记录时钟并停止记录操作。再次按下“暂停”(Pause) 按钮时，S7-PLCSIM 
继续记录（内部时钟再次启动）。  

单击“停止”(Stop) 按钮时，S7-PLCSIM 
将生成一个新的序列，并将其添加到项目中，同时系统会为其分配一个标准名称，例如“S
equence_3”。您可以在项目树中查看这一新序列及其被分配的名称。可以通过右键单击

系统生成的名称，将其重命名为任意您希望的名称。这一新序列中将填充从 SIM 
表中记录的所有操作。 

暂停记录 

单击 SIM 表工具栏上的“暂停记录”(Pause recording) 
按钮时，将暂停当前的记录会话。单击该按钮会暂停内部定时器。序列暂停期间执行的任

何操作都不会被包含在记录中。 

再次单击“暂停记录”(Pause recording) 
按钮时将重启记录过程，同时内部定时器恢复工作。 

如果在记录暂停期间单击“停止记录”(Stop recording) 按钮，记录会话将结束。 



在项目视图中工作  
6.9 在序列编辑器中工作 

 S7-PLCSIM V14 在线帮助 
134 编程和操作手册, V14, 09/2016, A5E38930223-AA 

结束记录会话 

当记录完所有期望的序列操作后，通过单击 SIM 表工具栏上的“停止记录”(Stop 
recording) 
按钮结束记录会话。新序列基于记录生成，将针对每个引起地址值发生变化的操作记录一

个步。S7-PLCSIM 
将根据每个操作的记录时间为相应的步分配时间。对于通过记录生成的序列，其第一个步

对应的操作始终设置为“立即启动”(Start immediately)。 

序列一旦生成并添加到项目后，便可以像其它序列一样正常使用，而且不存在特殊的行为

或限制。您可以随意修改或扩展该序列。 

6.9.5 序列的启动方式 

6.9.5.1 序列启动操作 

序列的第一行定义其启动条件。共有两个选项：“立即启动”(Start immediately) 
和“触发条件”(Trigger 
condition)。通过为启动步选择适当的操作在这两个选项之间进行选择。 

● “立即启动”(Start 
immediately)。选择该选项后，将立即激活序列的第一个步（序列编辑器的第二行），

并开始对序列的执行时间计时。 

● “触发条件”(Trigger condition)。对于该选项，必须定义一个触发条件，S7-PLCSIM 
将通过评估该触发条件来确定何时执行序列。如果为序列定义触发条件后选择了播放

序列，则只有在满足触发条件时才会激活序列中的第一步。 

为启动步选择合适的“操作”(Action)，以在这两个选项之间进行选择，如下图所示： 

 

新序列的默认启动操作为“立即启动”(Start 
immediately)。选定该选项作为启动操作时，无需编辑其它字段。“时间”(Time) 
字段将显示 
00:00:00.00（或等效时间，基于选定的时间格式）且无法编辑。选择该选项时，没有可

用的“操作参数”(Action parameter)。 
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“立即启动”(Start immediately) 

选择该选项后，将立即激活序列的第一个步（序列编辑器的第二行），并开始对序列的执

行时间计时。 

“立即启动”(Start immediately) 
为默认启动操作。选择该启动操作后，无需编辑任何其它字段。“时间”(Time) 字段将显示 
00:00:00.00（或等效时间，基于选定的时间格式）且无法编辑。选择该选项时，没有“操
作参数”(Action parameter)。 

“触发条件”(Trigger condition) 

选择该选项时，必须定义一个触发条件，S7-PLCSIM 
将通过评估该触发条件来确定何时开始执行序列。如果定义触发条件后选择了播放序列，

则只有在满足触发条件时才会激活第一个序列步。 

“触发条件”(Trigger condition) 需要额外进行编辑。必须在“操作参数”(Action parameter) 
列下定义启动条件。选择该选项时，“操作参数”(Action parameter) 
字段变为下拉列表，用以显示编辑控制对话框。  

触发条件定义为单一变量（或地址）的特定条件。该行为类似于 STEP 7 
跟踪的“触发条件”(Trigger condition) 功能。  

6.9.5.2 通过工具栏按钮重复序列 

序列的最后一个步为“停止序列”(Stop sequence) 
步。序列将在该步中指示的时间停止执行。所有激活的“设置为频率”(Set to frequency) 
操作均将停止，序列返回至可编辑的停止状态。 

然而，您可能希望以循环方式重复执行序列。为此，无论在何时，也不管序列是停止、暂

停还是播放状态，都可以单击“重复序列”(repeat sequence) 工具栏按钮 
。单击该按钮后，该按钮将显示为按下状态，用于指示序列正在重复。 

设置为重复的序列具备以下功能： 

● 当运行的序列到达“停止序列”(Stop sequence) 
步后，将停止所有激活的“设置为频率”(Set to frequency) 操作。 

● 对于设置为“立即启动”(Start immediately) 
的序列，将立即激活序列的第一个步，序列将再次执行定义的步。 

● “执行时间”(Execution time) 
字段中显示的时间是序列当前迭代的时间，而非从序列开始执行起累计的总时间。重

复序列的当前迭代次数 (1…n) 显示在执行时间旁边的括号内。 
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可以通过下列方式停止重复序列： 

● 单击“停止”(stop) 按钮。序列将立即停止。单击“停止”(stop) 
按钮不会影响“重复序列”(repeat sequence) 按钮的状态。 

● 取消选择“重复序列”(repeat sequence) 
按钮。在这种情况下，将在到达“停止序列”(stop sequence) 
步对应的时间后停止序列。 

请注意，序列重复设置不随序列一起保存到 S7-PLCSIM 项目中。  

6.9.5.3 通过触发条件启动序列 

以下截屏显示了开始组态触发条件之前“操作参数”(Action parameter) 
字段的默认对话框： 

 

要完全组态触发条件，必须输入以下信息： 

● 输入将用于触发条件的变量或地址 

● 输入将为变量监视的事件 

● 输入变量的触发值（如果需要） 

要输入变量或地址，可单击“触发变量”(Trigger tag) 
控件以查看当前组态中所有可用变量的列表： 
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可以从列表中选择变量，或者直接编辑字段来输入变量。选择触发变量后，将显示变量名

及关联的地址。 

也可以在“触发变量”(Trigger tag) 
字段中输入地址。如果该地址有关联变量，则在完成该条目后，变量名称会显示在“操作

参数”(Action parameter) 
字段中。如果该地址无关联变量，则在完成该条目后，只有地址会显示在“操作参数”(Acti
on parameter) 字段中。 

选择变量或地址时，还将确定可用的“事件”。在下方截屏中，已选择某个输入位地址作为

触发变量。事件字段显示默认值“= TRUE”。 

 

对于不同的数据类型，可用的事件也会有所不同。下表列出了不同地址所支持的事件类型

： 
 

地址类型 数据类型 支持的事件 

位地址 (%i0.0) Bool = TRUE 
= FALSE 

字节地址 (%mb0) 
字地址 (%mw0) 
双字地址 (%md0) 

SInt/Byte 
Int/WORD 
Dint/DWORD 

= 值 
<> 值 

双字地址 (%md0) Real > 值 
< 值 
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对于支持比较值的变量类型，对话框中的“值”(Value) 
字段将被启用。在如下示例中，用户选择了一个 WORD 地址。“值”(Value) 
字段被启用，用户必须输入一个比较值。 

 

当用户输入比较值后，错误指示将被移除。 

 

用户通过单击绿色复选框按钮  关闭控件后，“操作参数”(Action parameter) 
字段中将显示触发条件。  

 

蓝色“X”按钮  为取消按钮。单击该按钮后，将不保存任何更改。 

保存序列时，触发条件也会随之保存。重新打开项目时，触发条件将与之前保存项目时的

触发条件一样。 

导出序列时，触发条件随序列一起导出。如果重新导入一个包含触发条件的序列，触发条

件将保持激活状态。 
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6.9.5.4 重复执行组态为变量触发的序列 

对于设置为“触发条件”(Trigger condition) 的序列，如果为其选择了“重复序列”(Repeat 
sequence)，则每次重复序列时，都将再次评估启动条件。  

● 如果满足启动条件，则将立即激活序列的第一个步，序列将继续执行定义的步。 

● 如果不满足启动条件，则将暂停序列，直至满足启动条件后再继续照常进行。 

6.9.5.5 运行顺序时的视觉反馈 

播放序列时项目视图中的视觉反馈 

当序列正在激活运行时，S7-PLCSIM 提供以下视觉反馈：  
 

 在项目树中，“正在运行”(Running) 
图标显示在当前正在运行的序列旁边。如果序列已暂停，则会显示“
暂停”(Pause) 图标（而非“正在运行”(Running) 
图标）。通过这种方式，可以选择想要停止的正确序列。 

正在播放的序列： 

 

“序列播放”(Sequence playing) 
图标会在序列正在运行时显示在序列编辑器窗口的右下方。 

 “步骤执行”图标将在序列中逐步移动，表示执行到相应的步骤。如果

已定义多个步骤同时开始，则所有步骤都会显示绿色箭头。 

 执行时间将显示在序列编辑器工具栏中。  

停止序列后的视觉反馈 

可根据以下视觉指示器断定序列停止运行的时间： 

● 项目树中序列名称旁无“正在运行”(Running) 图标。 

● “序列播放”(sequence playing) 图标不再出现在序列编辑器窗口的右下角。 

● “步骤执行”图标将在执行的最后一个步骤停止。 

● 执行时间将停止并显示总的序列运行时间。如果序列是重复序列，则括号内显示重复

次数。 
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6.9.6 序列操作和操作参数 

序列中的每个条目或步骤都代表在“时间”(Time) 
列中指定的时间时，在指定地址上采取的操作。可以指定的操作类型取决于地址的数据类

型。  

可以在“名称”(Name) 字段中按照变量名称，或者在“地址”(Address) 
字段中按照地址来指定地址。序列条目的地址确定了其数据类型以及可用的操作。  

使用位地址的顺序示例 

以下示例介绍了步骤的地址如何确定位地址的可用选项： 

● 按照地址或变量名输入一个输入位地址。 

● S7-PLCSIM 将在序列行的剩余字段中填入默认值。 

● “设置为值”(Set to value) 操作为默认操作。对于操作参数，有两种选择：FALSE 或 
TRUE。 

● 如果想要“设置为频率”(Set to frequency) 操作而不是“设置为值”(Set to value) 
操作，使用下拉列表选择它并在“操作参数”(Action parameters) 字段中输入频率 
(Hz)。运行顺序时输入将以该频率发出脉冲。 

序列操作：“设置为值” 

“设置为值”(Set to value) 
是离散操作。换句话说，值只写入外围设备输入一次。但是，由于没有实际 I/O 
来覆盖此操作，指定的输入将保持该值，直到其它操作将其更改。  

序列操作：“设置为频率” 

“设置为频率”(Set to frequency) 
操作只能用于输入位存储器。对于其它所有地址区，以及其它所有输入地址大小（字节、

字、双字），只能使用“设置为值”(Set to value) 操作。 

操作为“设置为频率”(Set to frequency) 
时，生成脉冲的数据写入操作将继续执行，直到更改了该地址的操作，或直到序列停止。

如果为最后一步选择了“重复序列”(Repeat 
sequence)，则会继续执行数据写入操作，直至选择“停止序列”(Stop sequence)。  
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6.9.7 与时间相关的序列信息 

6.9.7.1 序列时间条目 

可以根据“时间”(Time) 
字段的内容，对序列条目进行排序和运行。时间将以下列格式进行显示：时:分:秒.小数秒 
(00:00:00.00)。  

如果选择了“时间”(Time) 字段并输入数字（例如 12），S7-PLCSIM 
会解释该数字并将其显示为 12 秒 
(00:00:12.00)。为获得时、分和小数秒，必须使用适当的格式明确地输入时间。  

条目允许的最大时间为 23:59:59.95（S7-PLCSIM 会将序列时间条目舍入为最接近的 50 
毫秒）。  

下表举例说明了序列中的时间值： 
 

输入的值 结果时间值 

12 00:00:12.00 

12.2 00:00:12.20 

.02 00:00:00.00 

2:2 00:00:02.20 

12:12.12 00:12:12.12 

空 00:00:00.00 

任何无效条目，如文本“abcd” 单元格变为粉色，出现一个错误图标，并显示导致

错误的文本。  

序列步的顺序 

无需按照待执行的顺序向序列中添加步。可按照任意顺序输入步，这些步将根据您在“时
间”(Time) 列中输入的时间运行。  

可以在运行序列之前通过选择“时间”(Time) 列标题来按照时间对步进行排序。 
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序列时间条目规则 

可以定义多个具有相同时间的条目，但这些条目不可具有相同的地址。如果同时为相同的

地址定义了多个操作，则将发生错误。  
 

 
说明 

时间相同的多个步骤 
如果同时为不同的地址定义了多个操作，则不会显示错误，但是在播放序列之前无法得知

将先执行哪个操作。这会导致地址的最终值不同。 
 

可以对“地址”(Address) 列排序，以根据受影响的输入地址来查看操作。  

停止序列和重复序列的序列结束时间 

对于停止序列和重复序列，序列最后一步的时间必须等于或大于序列最后一步的时间加上 
50 ms。 

序列时间条目示例 

如果希望输入点以某一频率脉冲五秒钟，然后清除输入，则以下两种序列示例均可实现这

一点。  

五秒之后结束序列：示例 1 

对于第一步，选择“设置为频率”(Set to frequency) 作为操作并在“操作参数”(Action 
Parameters) 字段中输入频率 (Hz)。 

对于第二步，在“时间”(Time) 字段中输入时间 00:00:05.00，选择“设置为值”(Set to value) 
作为操作，并在“操作参数”(Action Parameters) 字段中输入值“0”。 

五秒钟后将停止生成脉冲。 

五秒之后结束序列：示例 2 

也可以在序列最后一步的“时间”(Time) 字段中输入 
00:00:05.00。如果在最后一步中选择了“停止序列”(Stop 
sequence)，则还会在五秒钟之后停止生成脉冲。 
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6.9.7.2 序列步时间 

S7-PLCSIM 支持两种设置序列步时间的方式： 

● 可以指定同时执行操作 

● 可以指定按顺序执行步 

可以创建多个地址不同的步，然后设置相同的时间值。这并不属于错误条件。但是，如果

创建多个地址相同的步，然后设置相同的时间值，则属于错误条件。S7-PLCSIM 
会通过将错误字段的颜色改为红色来指示此错误条件。 

如果序列步包含的时间不同，则 S7-PLCSIM 仍会强制要求步间隔时间不得短于 
50 ms。如果输入的时间距离前一个步的时间不到 
50 ms，则属于错误条件，将在用户界面中进行指示。 

为了说明上述规则，请看以下示例： 

● 定义三个地址不同的步在同一时间执行。由于每个步在不同地址执行，因此不属于错

误。 

● 定义多个地址相同的步在同一时间执行。这属于地址冲突的错误条件。 

● 当手动输入步时间时，S7-PLCSIM 会将步时间舍入为最接近的 10 ms 
边界。您可以输入一个距离序列中前一个步的时间不到 50 ms 
的时间，这一操作是允许的。例如，在“时间”(Time) 字段中为某一个步输入 63 ms 
时，S7-PLCSIM 会将 63 ms 舍入为 
60 ms。这种情况不会产生错误。而当为下一个步输入 91 ms 
时间并提交编辑时，91 ms 时间将舍入为最接近的 10 ms（在此例中为 90 
ms）。由于该步的时间距离 60 ms 步不到 50 ms，因此将导致 90 ms 
步产生错误条件。 

● 编辑步时间时，“停止序列”(Stop sequence) 
步会自动更新，使时间等于最新一步的时间加上 50 ms。 
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6.9.7.3 编辑执行时间 

暂停序列时，将启用当前执行时间字段，以便用户能够编辑执行时间。通过编辑当前执行

时间，可以在不同位置处重启序列（返回到之前的步或者跳到之后的步）。 

请看下面的示例： 

 

其中，序列已在 12.82 秒处被暂停。序列暂停时没有新的步处于激活状态。 

现在，假定将执行时间编辑为 21.5 秒，然后单击“启动序列”(Start sequence)： 

 

序列操作将在对应于新执行时间的步启动。在本示例中，序列将跳过时间 21.0 
秒处定义的步，然后在 21.50 秒处定义的步开始操作。 

如果编辑的执行时间介于两个步之间，则单击“启动序列”(Start sequence) 
时将启动序列定时器，并会在达到下一步对应的时间时激活下一步。 

请注意，暂停序列时处于激活状态的步为“设置为频率”(set to frequency) 
操作。当您暂停序列并将执行时间向前移动时该步处于激活状态，因此再次启动序列时该

步仍然为激活状态。  

上述示例中将发生以下事件：  

● 序列暂停时，激活的步正在运行 %I0.3 的“设置为频率”(set to frequency) 操作。 

● 序列暂停后，对执行时间进行了编辑，跳过了序列中的下一个步。该步本来将停止“设
置为频率”(set to frequency) 操作。 

● 跳过该步后，允许 %I0.3 的“设置为频率”(set to frequency) 操作保持激活状态。 
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此外，还可通过编辑执行时间重新播放一部分序列。下面是暂停序列的原始示例： 

 

现在，假定将执行时间编辑为 0.00，单击“启动序列”(Start sequence)，然后在时间达到 
1.00 秒时单击“暂停序列”(Pause sequence)： 

 

激活步的时间为 00.00 秒，但未进行该步的相应操作，因为执行时间已被修改为 
1.00。另请注意，在 12.8 秒处暂停序列时处于激活状态的步（%I0.3 的“设置为频率”(Set 
to frequency) 
操作）不再为激活状态。由于已将时间设置为较早时间，因此再次单击“启动序列”(Start 
sequence) 时，“设置为频率”(Set to frequency) 操作将不会重新启动。 

● 如果将执行时间设置为 00.00 
秒，则将重启序列。在上述示例中，序列已经过组态，将在满足某个条件时启动。将

时间设置回 0.00 秒时，会导致需要再次评估启动条件。将执行时间编辑为 00.00 
秒，相当于停止序列并重新启动。 

● 不能将该时间设置为晚于最后一个步的时间。即使尝试这样设置，S7-PLCSIM 
也会将时间自动更正为停止/重复序列步的时间。如果此时选择重复序列，其效果将和

重启序列相同，即从第一个步开始。 

● 保存项目时，当前执行时间将不随项目一起保存。如果保存并关闭项目，任何处于暂

停状态的序列都将显示为已停止。 
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6.9.8 插入、添加和删除序列步 

打开一个新序列时，其中包含三行或三个步骤：  

● 对于第一步，指示符列包含“第一步”(First step) 图标 ，“时间”(Time) 
列包含“00:00.00:00”，“操作”(Action) 列包含“立即启动”(Start 
immediately)。不能编辑此步。 

● 空步，“时间”(Time) 列中包含“00:00.00.00”。 

● 对于最后一步，指示符列包含“最后一步”(Last step) 图标 ，“时间”(Time) 
列包含“00:00.00:05”，“操作”(Action) 列包含“停止序列”(Stop sequence)（默认值）。 

可通过编辑空行在新序列中创建第一个步。 

插入一个步 

插入一个步时，新步会出现在当前所选步的上方。 

可以通过下列方式之一来插入步： 

● 单击序列编辑器工具栏上的“插入步骤”(Insert step) 按钮  

● 右键单击步中的任意位置，然后从快捷菜单中选择“插入步”(Insert step)。 

添加一个步 

添加一个步时，新步会出现在当前所选步的下方。所添加步的时间将等于当前所选步的时

间加上默认间隔时间。 

可以通过下列方式之一来添加步： 

● 单击序列编辑器工具栏上的“添加步骤”(Add step) 按钮  

● 右键单击步中的任意位置，然后从快捷菜单中选择“添加步”(Add step)。 
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使用默认时间间隔 

如果要更改所添加步的默认时间，请在序列编辑器工具栏的“默认时间间隔”(Default 
interval) 文本框中输入其它值。新步的时间将为所选步的时间加上默认间隔时间值。  

 

例如，如果当前步的时间为“00:00:05.00”并且输入“2000”作为默认步时间间隔，则新增步

的时间将为“00:00:07.00”。  

添加新步时，默认间隔时间将添加到所选步及所有后续添加步的时间中。  
 

 
说明 

默认时间间隔对插入步的影响 
默认步时间间隔仅用于新增的步。如果插入步，则所插入步的时间即为当前所选步的时间

减去默认间隔时间值。 
 

默认时间间隔的有效范围为 50 到 5000 ms。输入值将舍入为最接近的且为 10 ms 
整数倍的值。 

例如，如果输入“1445”，则默认时间间隔将舍入为“1450”。 

以下为无效输入示例，这将导致默认时间间隔恢复为先前的值，在先前没有默认时间间隔

值时恢复为“50”： 

● “9999” 

● "b" 

● “- 100” 

删除一个步  

要删除一个步，请选择要删除的步，然后执行以下操作之一：  

● 单击键盘上的“删除”键 

● 单击“删除”(Delete) 工具栏按钮 

● 单击右键，然后从快捷菜单中选择“删除”(Delete)。 
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6.9.9 启用和禁用序列步 

您可以临时禁用序列中的一个或多个步。播放序列时，禁用的步将被忽略。借助这项功能

，可以灵活地调试序列。通过单击操作即可将禁用的步重新启用，从而将其包含在下一次

播放的序列中。 

要禁用步，请执行以下操作： 

1. 通过选择整行或者单击行中的某个单元格选择步 

2. 单击序列编辑器工具栏上的“禁用步”(Disable step) 按钮 。 

可以同时禁用多个步，方法是先选择多个步，然后再单击“禁用步”(Disable step) 按钮。 

可以重新启用步，方法是先选择该步，然后单击“启用步”(Enable step) 按钮 。 

禁用和启用步的相关规则 

可以禁用包含错误的步。在这种情况下，行的错误图标将替换为禁用图标。这样一来，便

可以忽略错误播放序列。 

可以随意编辑禁用的步。如果编辑步时致其无效，则在其重新启用之前，该步不会标记有

错误。这种情况下不会阻止您运行序列。 

无法禁用“启动序列”(Start sequence) 步和“停止序列”(Stop sequence) 
步。如果选择其中一个步并单击“禁用步”(Disable step) 
按钮，将不显示任何错误且不会禁用该步。 

复制和粘贴步时，将保留其启用或禁用状态。 

导出序列时，将保留步的启用或禁用状态。当再次导入序列时，任何禁用的步都将以禁用

状态被导入。 

按时间或地址对表进行排序时，也会对禁用的步进行排序。 

禁用某个步时，可能会改变序列中其它步的状态。例如，如果在同一时间、同一地址处存

在多个操作，则可能会收到一条错误消息。可以通过选择并禁用其中一个步，同时为这些

步清除此类错误。 
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6.9.10 步时间调整 

编辑和调试序列时，可能需要在序列中间插入一个步。为此，您可能想要将该步后面的所

有步都延迟一定的时间。 

要实现这一目的，请参照以下示例： 

● 测试序列后，决定要在 02.00 秒和 02.50 
秒的两个步之间插入一个新步。首先使用“插入步”(Insert step) 
按钮在适当位置处创建一个空步，然后编辑该步。 

● 您希望为序列中该步后面的所有步添加一个 0.50 
秒的延时。为此，可以手动编辑每个步的时间，也可以先选中这些步，然后单击右键

并选择“步时间调整”(Step time adjustment)。 

● 该操作允许您为所有选定的步添加一段正/负时间。选择该快捷菜单选项后将显示一个

小对话框，您可以在该对话框中输入一段时间，以添加到每个步的时间中。 

– 如果添加的时间为正，则为每个步的“时间”(Time) 值加上这一时间值。 

– 如果添加的时间为负，则为每个步的“时间”(Time) 
值减去这一时间值。如果为任意时间减去这一个时间值后致其变为负值，则会将其

设置为 00.00。 

步时间调整操作不适用于序列的启动步。启动步总是从时间零开始。即使选中多行时包含

了启动步，也不会对启动步进行更改。 

步时间调整操作适用于“停止序列步”。可以单独编辑该步的时间，也可以与其它步一起编

辑。 

最短延时（正延时或负延时）为 10 ms。 

“步时间调整”(Step time adjustment) 操作无法撤消。  

一个带有文本输入字段的对话框用于指示延迟时间。 

6.9.11 同时运行多个序列 

一个项目中可以有多个序列，但一次只能运行一个序列。如果有一个序列在运行，“启动

序列”(Start sequence) 按钮对于任何其它序列都处于非激活状态。  

6.9.12 序列错误条件 

序列条目存在错误条件时，出错的单元格将变为粉色，且红色的“X”图标  
会出现在指示符列中。可以将鼠标悬停在错误条目的上方，以显示相关错误消息。  
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只要序列中存在错误条件，就无法播放序列。  

顺序可能出现的错误如下： 
 

错误 说明 

未定义的变量名 输入的变量名与从 STEP 7 下载的内容不匹配 

地址无效 地址语法错误 

无效时间 时间语法错误 

无效操作参数 操作参数语法不正确，或者地址超出范围 

操作参数的“设置为频率”(Set to 
frequency) 值超出范围 

有效范围为 1 到 100 ms 

步重复 两个步试图在同一地址同时运行 

步间隔过小 S7-PLCSIM 强制要求任意两个步之间的最短时间为 
50 ms 

未在线 在尝试运行序列时，STEP 7 不处于在线状态 

仅成功执行部分导入操作 Microsoft Excel 文件中的一个或多个地址丢失 

请注意，序列编辑器不会检查地址是否处于有效范围，但会尝试监视地址的语法是否错误

。 



 

S7-PLCSIM V14 在线帮助 
编程和操作手册, V14, 09/2016, A5E38930223-AA 151 

 仿真通信 7 
7.1 仿真通信概述 

S7-PLCSIM V14 支持仿真实例间的通信。实例可以是 S7-PLCSIM V14 仿真、WinCC 
运行系统仿真或 S7-PLCSIM V5.4.7 仿真。  

可以运行两个 S7-PLCSIM V14 实例、最多八个 S7-PLCSIM V5.4.7 
实例、乃至更多数量的 WinCC 运行系统仿真，而且它们之间可互相通信。  

S7-PLCSIM 如何仿真通信 

启动仿真时，S7-PLCSIM 
会禁用外部网络，然后通过通信仿真驱动程序路由通信请求。该驱动程序接收通信请求，

并基于 S7-PLCSIM 分配和管理的网络地址将其路由给特定的仿真实例。  

仿真实例间的通信 

所有仿真实例必须在同一 PC 上运行才能相互通信。每个实例的 IP 地址都不得重复。 

S7-PLCSIM V14 支持 TCP/IP 和 PROFINET 连接。  

对于 S7-1200 PLC，可使用 GET/PUT 和 TSEND/TRCV (T-block) 指令来仿真通信。  

对于 S7-1500 和 ET 200SP PLC，可使用 GET/PUT、BSEND/BRCV、TSEND/TRCV 
(T-block) 和 TSEND_C/TRCV_C (T-Block) 指令来进行仿真。 

T-Block 指令和数据缓冲 

S7-PLCSIM V14 执行 T-Block 指令时无需在接收 CPU 中缓冲数据。  

只有仿真的接收 CPU 中的程序执行 TRCV 指令后，仿真的发送 CPU 才能完成 TSEND 
指令。 

每个仿真的 PLC 的 IP 地址都不得重复 

如果每个仿真的 PLC 都具有相同的 IP 地址，则无法运行多个仿真。每个仿真的 PLC 的 
IP 地址都不得重复。  

 



仿真通信  
7.2 运行多个并发仿真 

 S7-PLCSIM V14 在线帮助 
152 编程和操作手册, V14, 09/2016, A5E38930223-AA 

7.2 运行多个并发仿真 
S7-PLCSIM V14 能够对支持的 CPU 
类型的任意组合进行两个并发仿真。仿真必须具备唯一的 IP 
地址，才能实现正常通信和功能。但是，启动 IP 
地址与已运行实例冲突的第二个仿真是不受限制的，因此应适当加以避免。 

此外，还可以同时运行 S7-PLCSIM V14 仿真和 S7-PLCSIM V5.x 仿真。  

如果在两个并行仿真处于激活状态时尝试启动第三个仿真，则会收到一条错误消息，提示

您实例数量已达到最大值，无法再启动第三个仿真实例。例如，通过下列方式尝试启动第

三个并行仿真时就会收到错误消息： 

● 从桌面或开始菜单启动 S7-PLCSIM，然后尝试启动新的仿真 

● 尝试通过 STEP 7 中的“启动仿真”(Start simulation) 选项启动 S7-PLCSIM 

● 双击保存了仿真的现有 S7-PLCSIM 项目 

请记住，S7-PLCSIM V14 中的“仿真”和“项目”存在区别。无需创建 S7-PLCSIM 
项目即可启动仿真。同理，也可以创建或打开 S7-PLCSIM 
项目，而不启动仿真。双实例限制会强加给仿真。  

当已存在两个激活的仿真时，并不会阻止您创建 S7-PLCSIM 项目。只要 S7-PLCSIM 
项目中没有运行的仿真，并不会强加限制可以打开的项目数量。 
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7.3 PLC 系列之间支持的通信指令 
下表按照通信指令和 PLC 对汇总了有效的 PLC 与 PLC 间的连接： 

 

GET / PUT 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 √ √ √ √ √ 

S7-400 √ √ √ √ √ 

S7-1200 √ √ √ √ √ 

S7-1500 √ √ √ √ √ 

ET 200SP √ √ √ √ √ 

 
 

BSEND / BRCV 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 √ √ - √ √ 

S7-400 √ √ - √ √ 

S7-1200 - - - - - 

S7-1500 √ √ - √ √ 

ET 200SP √ √ - √ √ 

 
 

USEND / URCV 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 √ √ - √ √ 

S7-400 √ √ - √ √ 

S7-1200 - - - - - 

S7-1500 √ √ - √ √ 

ET 200SP √ √ - √ √ 
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TSEND / TRCV 

 CPU #1 

S7-300 S7-400 S7-1200 
(SFB 100, 

101) 

S7-1200 
(SFB 150, 

151) 

S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - - 

S7-400 - - - - - - 

S7-1200 
(SFB 100, 
101) 

- - √ √ √ √ 

S7-1200 
(SFB 150, 
151) 

- - √ √ √ √ 

S7-1500 - - √ √ √ √ 

ET 200SP - - √ √ √ √ 

 
 

TUSEND / TURCV 

 CPU #1 

S7-300 S7-400 S7-1200 
(SFB 100, 

101) 

S7-1200 
(SFB 150, 

151) 

S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - - 

S7-400 - - - - - - 

S7-1200 
(SFB 100, 
101) 

- - - - - - 

S7-1200 
(SFB 150, 
151) 

- - - - - - 

S7-1500 - - - - - - 

ET 200SP - - - - - - 
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TSEND_C / TRCV_C 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - 

S7-400 - - - - - 

S7-1200 - - √ √ √ 

S7-1500 - - √ √ √ 

ET 200SP - - √ √ √ 

 
 

TUSEND_C / TURCV_C 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - 

S7-400 - - - - - 

S7-1200 - - - - - 

S7-1500 - - - - - 

ET 200SP - - - - - 

 
 

MODBUS TCP 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - 

S7-400 - - - - - 

S7-1200 - - - - - 

S7-1500 - - - - - 

ET 200SP - - - - - 
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TMAIL 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - 

S7-400 - - - - - 

S7-1200 - - - - - 

S7-1500 - - - - - 

ET 200SP - - - - - 

 
 

TMAIL_C 

 CPU #1 

S7-300 S7-400 S7-1200 S7-1500 ET 200SP 

 

 

 

CPU #2 

S7-300 - - - - - 

S7-400 - - - - - 

S7-1200 - - - - - 

S7-1500 - - - - - 

ET 200SP - - - - - 
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错误条件和限制 8
8.1 概述

特定的操作或事件可能导致 S7-PLCSIM 或 STEP 7 
出现错误或行为异常。下文介绍了所有已知的问题和相应的变通方法。

8.2 特定错误条件和限制

8.2.1 试图下载到 S7-PLCSIM 后出现编译错误 

试图将 STEP 7 程序下载到 S7-PLCSIM 
时，您可能会收到一条错误，指示用户程序尚未编译，应重新编译。

您可能会在下列条件下遇到这种情况：

● 仿真从物理 PLC 上传的程序时

● 仿真已被复制粘贴到项目中的程序时

该错误与运动控制程序中自动生成的程序块（例如，MC-Servo 和 MC-Interpolator 
OB）关联。  

要消除该错误，请删除自动生成的块，然后通过命令“编译 > 
软件（重新编译所有块）”(Compile > Software (rebuild all blocks)) 
重新编译程序。该命令会正确重新创建并编译块，以供 S7-PLCSIM 
使用。不过，在删除块之前，请检查 OB 中的设置。 

请注意，此错误并非仅限于运动控制。只要程序包含自动生成的块，都可能会遇到此问题

。删除自动生成的块后，程序应会成功编译并下载至 S7-PLCSIM。 

8.2.2 HMI 可访问变量 

“HMI 可访问”变量在 SIM 表或序列中不可用。 
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8.2.3 针对多个未组态的 CPU 仿真通信时出错 

运行多个 S7-PLCSIM 实例并试图仿真多个未组态的 CPU 
之间的通信时，可能会出错。如果每个仿真的 IP 地址均相同，则会出现这种错误。 

示例

● 启动 S7-PLCSIM 并为 S7-1500 CPU 启动仿真

● 启动第二个实例，然后为 ET 200SP CPU 启动仿真

● 在 TIA Portal 中，选择 ET 200SP CPU 并试图将其下载到 ET 200SP 仿真。

结果：您将收到一条“设备不兼容”消息，或者 ET 200SP 将下载到 S7-PLCSIM S7-1500 
仿真中。在这种情况下，第一个做出响应的仿真器可能不是您的首选仿真器。

原因：在未组态状态下，每个仿真均会对所有 IP 地址做出响应。 

解决方案

避免一次启动多个未组态的仿真。如果打开了多个未组态的仿真，请关闭电源或者仅保留

一个仿真（其它仿真均关闭）。

8.2.4 “剪切”操作在各 S7-PLCSIM 实例之间执行“复制”操作 

在两个打开的 S7-PLCSIM 
实例之间执行剪切和粘贴操作时，源实例中的数据会被复制而不是被剪切。

操作描述

启动两个 S7-PLCSIM 实例，并在两个实例中创建一个仿真项目。 

将地址输入到其中一个实例的 SIM 表或序列中。 

剪切其中一行或多行，并将其粘贴到另一个实例的 SIM 表或序列中。 

请注意，剪切项将被复制，而不是被剪切和删除。剪切项按预期显示在第二个实例中，但

仍会保留在源实例中。

解决方案

要解决此问题，可删除源实例中已剪切或复制的行。
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8.2.5 使用 HMI 和多个 PLC 仿真通信 

如果要使用 HMI 仿真多个 PLC，可能会遇到由 S7-PLCSIM 
仿真通信的方式所导致的意外连接行为。

为了避免这一问题，请在启动 HMI 之前启动所有 PLC 仿真。 

说明

如果在启动所有 PLC 仿真之前已启动 HMI 并注意到了意外行为，请在 PLC 
保持激活状态的同时关闭 HMI 并重新启动。 

8.2.6 避免仿真 S7-1500 时强制输入 

仿真 S7-1500 或 ET 200SP CPU 时强制输入可能导致意外行为。请使用 S7-PLCSIM 
SIM 表为这些 PLC 修改输入值。 

8.2.7 进入 RUN 模式后稍作等待以访问运动控制工艺对象 

与物理 PLC 相比，仿真 PLC 
处理运动控制命令的速度较慢。由于处理时间的差异，如果进入 RUN 
模式后过快地访问运动控制对象可能会遇到“错误”或“繁忙”状态。出现这种情况的原因可

能是对象尚未处理完成。

为避免出现这种情况，在使 PLC 进入 RUN 
模式后稍作等待，然后再访问运动控制对象。

有关运动控制的更多详细信息，请参见帮助部分“所有受支持的 PLC 
的常见区别”>“仿真运动控制”。 

8.2.8 仿真故障安全程序

仿真过程中，故障安全程序可能会意外切换到 STOP 模式。出现这种情况是因为仿真 
PLC 和实际 PLC 的扫描周期不同。  

要更正这种情况，按照以下步骤在 STEP 7 中增大 F 参数值： 

1. 在巡视窗口中，转到“常规 > 故障安全 > F 参数”(General > Fail safe > F
parameter)，然后将“集中式 F I/O 的默认 F 监视时间”(Default F monitoring time for
central F I/O) 设置为允许的最长时间 (65535 ms)。

2. 从 STEP 7 再次执行下载，然后再次运行仿真。
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8.2.9 对故障安全 I/O 使用 STEP 7 安全系统库 v1.3 或更高版本 

为成功仿真和调试包含故障安全 I/O 的项目，该项目必须使用安全系统库 v1.3 
或更高版本。如果项目使用该系统库的较旧版本，则故障安全 I/O 仿真将无法正常工作。 

8.2.10 使用全局库 

如果项目使用库，则必须先对硬件和软件进行编译，然后再执行到 S7-PLCSIM 
的下载操作。如果仅选择部分编译，则无法完成下载操作。  

8.2.11 序列“设置为频率”值的有效范围 

By default, S7-PLCSIM V14 支持在序列编辑器的“操作”(Action) 
列中将输入位的“设置为频率”(Set to frequency) 值设为 1 到 100 Hz。 

如果 S7-PLCSIM 生成的频率输入不可靠，请将“设置为频率”(Set to frequency) 值更改为 
16 Hz 或更低频率后再次运行序列。 

8.2.12 从多个 OB 调用的 S7-1500 EN_AIRT 和 DIS_AIRT 指令的错误 RET_VAL 
参数值 

如果从同一 OB 调用扩展中断指令 EN_AIRT 和 DIS_AIRT，则它们可正确用于 S7-1500 
项目。 

如果从多个 OB 调用这些指令，则这些指令无法正常工作。如果从多个 OB 
调用这些指令，则 RET_VAL 参数值可能不正确。  

8.2.13 循环事件溢出错误 

如果您的仿真中包含循环中断，则可能会溢出 S7-PLCSIM 循环事件队列。由于 
S7-PLCSIM 
的执行速度与实际硬件有关，因此创建诊断缓冲区条目花费的时间可能比下一次发生循环

中断事件之前的时间更长。  

如果发生这种情况，队列中会另外插入一个条目，进而导致更多溢出。S7-PLCSIM 
通过诊断缓冲区消息和项目树中的红色出错图标提供直观的溢出报告。 
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如果队列溢出，请转至“选项 > 设置 > 周期时间监视”(Options > Settings > Cycle time 
monitoring)。然后可以执行以下两个操作之一： 

● 选中“禁用扫描循环监视”(Disable scan cycle monitoring) 复选框。 

● 选中“指定最大周期时间”(Specify maximum cycle time) 
复选框，然后在“最大周期时间”(Maximum cycle time) 
框中输入一个较大的值。可输入一个不超过 60000 ms 的时间。 

采取以上措施后，必须通过 STEP 7 再次执行下载，所做更改才能生效。 

8.2.14 密码保护级别和仿真 

不能在 HMI 中组态 PLC 保护密码然后下载到 S7-PLCSIM。  

如果尝试在设定的保护级别下运行仿真，则 HMI 会接收到错误消息且无法连接到 
S7-PLCSIM。S7-PLCSIM 不会检查保护级别，因而指示未设置密码。  

若已设定 PLC 
保护级别，则必须先删除这些信息才运行仿真。完成仿真之后，可重置保护级别。 

8.2.15 STEP 7 在线与诊断功能 

STEP 7 在线与诊断功能 

一些在线和诊断功能对仿真没有实际作用。使用这些功能可能导致 S7-PLCSIM 
出现异常。其中包括：  

● 分配 IP 地址 

● 格式化存储卡 

● 分配名称 

● 固件更新 

8.2.16 待机模式期间的仿真 

当您的计算机或编程设备进入“待机”或“睡眠”模式时，仿真可能会停止。如果发生这种情

况，STEP 7 与 S7-PLCSIM 
之间的通信可能会暂停。当您的计算机或编程设备再次变为激活状态时，可能需要重新建

立连接，或者在某些情况下，需要重新打开您的仿真项目。  

要避免这种情况，请禁用您的计算机或编程设备的待机模式。 
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8.2.17 通过远程桌面连接运行 S7-PLCSIM 

可以通过远程桌面连接来运行 
S7-PLCSIM。但是，组态期间应避免与桌面客户端断开连接。在极少数情况下，这可能

会导致软件用户界面没有反应。  

如果遇到此情况，请在桌面客户端上按以下步骤操作： 

1. 打开 Windows 任务管理器，结束“rdpclip.exe”进程。 

2. 在命令提示中键入“rdpclip.exe”以重新启动该进程。 

请注意，剪切板的当前内容将丢失。不过，之后可继续正常组态。  

应尽快重新启动 S7-PLCSIM。 

8.2.18 使用自动同步的网络驱动器 

网络中断后的自动同步会使当前（本地）项目数据以“备份”的形式存储在网络驱动器上。

这样在打开项目时将从网络驱动器中加载过期的项目数据。为此，建议不要在同步网络驱

动器上存储 S7-PLCSIM 项目。  

但是，如果您使用同步驱动器，当网络中断时可以继续在本地工作。在这种情况下，必须

始终确保在同步数据时已关闭 S7-PLCSIM 
应用程序。同步本身必须以当前（本地）项目数据替换网络驱动器上的项目数据的形式实

现。 

8.2.19 项目菜单延迟 

如果最近使用的项目列表中的某个项目位于未连接的网络驱动器上，当打开项目菜单时可

能会有延时并可能崩溃。  

要更正此问题，请重新连接网络驱动器，或将项目文件夹移动到已连接的驱动器上。 

8.2.20 助记符选择 

如果使用德语助记符创建项目，然后切换用户界面语言，则由于小数点的表示方式存在差

异，因而可能会出现错误。  

为避免出现此问题，请使用国际助记符格式（例如，使用“1.23”，而不使用“1,23”）。 
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符号 

主菜单:,  

Ｅ 

ET 200SP 
PID 工艺对象, 36 
PID 控制工艺模块, 35 
ss 工艺对象, 36 
工艺对象支持, 36 
工艺模块支持, 35 
支持的指令, 37 
计数和测量工艺对象, 36 
计数和测量工艺模块, 35 
运动控制工艺模块, 35 
固件, 35 
故障安全, 35 
基于时间的 IO 工艺模块, 35 

ET 200SPF 
F 监视时间, 35 
支持的指令, 37 

Ｈ 

HMI, 151 
HMI 可访问变量, 157 

Ｉ 

I/O 设备支持, 26 
IP 地址和通信, 151 

Ｌ 

LED, 26 

Ｍ 

MRES, 55 

Ｐ 

PROFINET, 151 

Ｒ 

RUN 模式, 25 
工具栏中的设置, 70 
执行菜单中的设置, 62 

RUN/STOP, 70 

Ｓ 

S7-1200 
PID 工艺对象, 32 
PID 控制工艺模块, 31 
工艺对象模块支持, 32 
工艺模块支持, 31 
支持的指令, 32 
计数工艺模块, 31 
有效固件版本, 31 
运动控制工艺对象, 32 
运动控制工艺模块, 31 
故障安全, 31 
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S7-1200F 
F 监视时间, 31 
支持的指令, 32 
有效固件版本, 31 

S7-1500 
PID 工艺对象, 34 
PID 控制工艺模块, 33 
ss 工艺对象, 34 
工艺对象支持, 34 
工艺模块支持, 33 
支持的指令, 34 
计数和测量工艺对象, 34 
计数和测量工艺模块, 33 
运动控制工艺模块, 33 
固件, 33 
故障安全, 33 
基于时间的 IO 工艺模块, 33 

S7-1500F 
F 监视时间, 33 
支持的指令, 34 

S7-PLCSIM V14 Advanced, 14 
S7-PLCSIM V5.x, 14 
S7-PLCSIM 概述, 11 
SD 卡, 27, 27, 27 
SIM 表, 101 

一致修改, 108 
工具栏, 107 
加载项目变量, 110 
导入, 113 
导出, 113 
位, 108 
位列, 116, 117 
快捷菜单, 109 
启用/禁用非输入的修改, 107 
和序列通用的功能, 101 
注释, 108 

指示符列, 108 
显示格式, 108 
修改所有选定的值, 107 
说明, 106 
统一修改列, 116 
监视/修改值, 108 
监视/修改值列, 116 
概述, 109 
错误条件, 118 

SIM 表编辑器 
一致修改, 117 
记录操作以创建序列, 118 
自动填充, 110 
批量修改, 117 
复制和粘贴, 111 
粘贴结构化变量, 112 
撤消和恢复, 110 

SIM 表填充 
概述, 110 

STEP 7 
导出跟踪文件, 129 

STEP 7 许可证 
Basic 许可证, 15 
Professional 许可证, 16 

STOP 模式, 25 
工具栏中的设置, 70 
执行菜单中的设置, 62 

Ｔ 

T-Block 指令 
数据缓冲, 151 

TCP/IP, 151 
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Ｗ 

Web 服务器, 27 
WinCC, 151 

Ｇ 

工具栏, 58 
CPU 系列选择器, 69 
电源开/关按钮, 69 
记录/播放命令, 71 
执行命令, 70 
项目命令, 69 
项目视图, 68 
窗口命令, 70 
编辑命令, 69 

工具提示级联, 63 

Ｙ 

已安装的软件, 67 

ＺＨ 

专有技术保护, 26 
支持的 STEP 7 程序, 25 

Ｑ 

切换到项目视图, 18 
切换到精简视图, 18 
切换视图, 18 

Ｊ 

仅成功执行部分导入操作, 114, 119 

Ｄ 

电源按钮, 20 

Ｙ 

用户名, 63 
用户界面 

分割窗口, 66 
项目视图, 57 

ＺＨ 

主菜单 
执行, 62 
帮助功能, 67 
帮助系统, 67 
项目, 59 
窗口命令, 66 
编辑, 61 

Ｊ 

记录和播放, 125 

ＺＨ 

执行时间, 121 
执行菜单, 62 
执行菜单命令, 58 

Ｚ 

在序列中插入一个步骤, 120 
在线支持, 39 
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Ｃ 

存储位置和设置, 64 
存储器复位, 55 

Ｆ 

仿真 
RUN 模式和 STOP 模式, 25 
和电源按钮, 20 

仿真状态, 89 
仿真通信, 151 
仿真错误, 157 

Ｚ 

自动工具提示级联, 63 
自定义工作区, 70, 77 

Ｄ 

多实例 
复制和粘贴, 158 

ＳＨ 

设备组态, 73 
硬件, 98 

设备组态用户界面, 97 
地址部分, 98 
硬件组态部分, 98 

设置为值, 140 
设置为频率, 140 

Ｆ 

访问保护, 26 

Ｄ 

导入/导出 
序列中, 127 

导入文件中的空地址字段, 114, 119 
导出跟踪 

Microsoft Excel .csv 文件, 129 
变量跟踪记录文件, 129 

Ｙ 

运动控制, 27 
TO_ExternalEncoder, 29 
TO_PositioningAxis, 29 
工艺对象, 28 
回原点模式, 28 
限制, 28 

ＳＨ 

时间条目, 141 
允许的最大值, 141 

ＺＨ 

助记符设置, 63 

Ｊ 

近期项目列表, 63 

Ｙ 

应用程序设置, 63 
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Ｘ 

序列 
工具栏, 120 
从 Excel 导入, 121 
从跟踪测量导入, 121 
可编辑的步, 123 
立即启动, 123 
执行时间, 121 
地址列, 122 
地址相同的多个步骤, 142 
当前步, 123 
自动填充, 125 
自动填充与默认时间间隔, 126 
创建和填充, 124 
名称列, 122 
导入/导出, 128 
导入/导出和时间字段, 128 
导入跟踪文件, 129 
导出到 Excel, 121 
运行多个, 149 
步, 123 
时间列, 122 
时间格式设置, 121 
快捷菜单, 123 
启用一个步, 120 
启动序列, 120 
和 SIM 表通用的功能, 101 
注释列, 122 
视觉反馈, 139 
指示符列, 122 
显示格式列, 122 
重命名, 120 
重复序列, 121 
复制和粘贴, 126 
复制和粘贴与默认时间间隔, 126 
保存窗口设置, 121 

监视表条目, 128 
调整步时间, 120 
通过跟踪文件进行创建, 129 
停止步, 123 
停止序列, 121 
粘贴结构化变量, 126 
添加一个步, 120 
插入一个步, 120 
暂停序列, 121 
禁用一个步, 120 
错误条件, 149 
错误指示符, 123 
触发启动, 123 
播放期间的撤消和恢复, 124 
撤消和恢复, 124 
操作列, 122 
操作参数列, 122 
默认时间间隔, 121, 126 

序列中的无效地址, 149 
序列中的不兼容数据类型, 149 
序列中的未定义错误, 149 
序列中的重复地址, 149 
序列中的错误, 149 
序列中的操作冲突, 149 
序列编辑器 

地址, 119 
设置为值, 140 
设置为频率, 140 
时间, 141 
时间条目示例, 142 
删除一个步, 147 
添加一个步, 146 
插入一个步, 146 
概述, 119 
操作, 140 
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默认步, 146 
默认时间间隔, 147 

Ｋ 

快捷键, 78 

Ｑ 

启用自动工具提示级联, 63 

ＺＨ 

诊断错误, 26 

ＣＨ 

拆分画面, 77 

Ｑ 

取消固定编辑器画面, 77 

Ｇ 

固件升级, 16 
固件兼容性, 16 
固件错误, 16 
固定编辑器画面, 77 

Ｍ 

命名项目, 86 

Ｆ 

服务与支持, 39 

ＺＨ 

周期时间设置, 64 

Ｂ 

帮助系统, 67 
搜索, 39 

帮助菜单命令, 59 

Ｘ 

项目 
文件扩展名, 69, 86 
打开, 69 
创建, 86 
位置, 64 
保存, 69 
属性, 88 
新建, 69 
数据包含于, 86 

项目存储位置, 86 
项目状态, 89 
项目视图, 57 

工具栏, 68 
项目视图工具栏 

CPU 系列选择器, 70 
工具栏中的电源设置, 70 

项目树, 58, 72 
SIM 表文件夹, 73 
序列文件夹, 73 

项目菜单, 59 
项目菜单命令, 58 
项目属性, 58 
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ＺＨ 

指令 
BSEND/BRCV, 151 
PUT/GET, 151 
TSEND/TRCV, 151 
USEND/URCV, 151 

Ｄ 

带有进度显示的状态栏, 58 

Ｂ 

标题栏, 58 

Ｘ 

选项菜单命令, 59 

ＺＨ 

重命名 SIM 表, 73 
重命名序列, 73 
重置为默认设置, 63 

Ｆ 

复制保护, 26 

Ｂ 

保存工作区设置, 77 

Ｙ 

语言设置, 63 

Ｊ 

结构化变量, 128 

Ｐ 

配方, 27 

Ｔ 

通信 
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